Zebra® Card Printer

CardStudio™ Reference Manual
Copyright Notice

© 2010 ZIH Corp.

This document contains information proprietary to Zebra Technologies Corporation. This document and the information contained within is Copyrighted by Zebra Technologies Corporation and may not be duplicated in full or in part by any person without written approval from Zebra Technologies Corporation.

While every effort has been made to keep the information contained within current and accurate as of the date of publication, no guarantee is given that the document is error-free or that it is accurate with regard to any specification. Zebra Technologies Corporation reserves the right to make changes, for the purpose of product improvement, at any time.

Trademarks

CardStudio is a trademark and Zebra is a registered trademark of Zebra Technologies Corporation. Windows is a registered trademark of Microsoft Corporation in the United States and other countries. All other trademarks or registered trademarks are marks of their respective holders.
## Contents

1 • Introduction ................................................................. 1
   1.1 Overview ................................................................. 1
   1.2 Features ................................................................. 2
   1.3 CardStudio Software Versions ................................... 3

2 • Create a Card .............................................................. 5
   2.4 CardStudio Software Overview ................................... 5
   2.5 Build a Card ............................................................. 7
      2.5.1 Run CardStudio ..................................................... 7
      2.5.2 Pick a Template (pre-designed card) ......................... 8
      2.5.3 Modify Template Objects ......................................... 9
      2.5.4 Save the Template as Your Card Design ..................... 17
   2.6 Print Cards .............................................................. 18
      2.6.1 Locate and open your card design ......................... 18
      2.6.2 Switch to Database View ...................................... 19
      2.6.3 Add a new record ............................................... 20
      2.6.4 One-time camera setup ........................................ 21
      2.6.5 Take a picture with the camera .............................. 22
      2.6.6 Print the card .................................................... 23

3 • Toolbars ..................................................................... 25
   3.1 Introduction ............................................................. 25
   3.2 Design Toolbar (Design View) .................................... 26
   3.3 Drawing Toolbar (Design View) .................................. 27
   3.4 Database Toolbar (Database View) ............................. 28
   3.5 Batch Print Toolbar .................................................. 29
### 4 • Main Window

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.1</td>
<td>Introduction</td>
<td>31</td>
</tr>
<tr>
<td>4.2</td>
<td>Design View</td>
<td>32</td>
</tr>
<tr>
<td>4.3</td>
<td>Dashboard</td>
<td>37</td>
</tr>
<tr>
<td>4.3.1</td>
<td>Source Dashboard</td>
<td>38</td>
</tr>
<tr>
<td>4.3.2</td>
<td>Position Dashboard</td>
<td>39</td>
</tr>
<tr>
<td>4.3.3</td>
<td>Line Dashboard</td>
<td>40</td>
</tr>
<tr>
<td>4.3.4</td>
<td>Fill Dashboard</td>
<td>41</td>
</tr>
<tr>
<td>4.3.5</td>
<td>Text Dashboard</td>
<td>42</td>
</tr>
<tr>
<td>4.3.6</td>
<td>Image Dashboard</td>
<td>43</td>
</tr>
<tr>
<td>4.3.7</td>
<td>Effects Dashboard</td>
<td>44</td>
</tr>
<tr>
<td>4.3.8</td>
<td>Bar Code Dashboard</td>
<td>45</td>
</tr>
<tr>
<td>4.3.9</td>
<td>2D Bar Code Dashboard</td>
<td>46</td>
</tr>
<tr>
<td>4.3.10</td>
<td>Clip-Art Dashboard</td>
<td>47</td>
</tr>
<tr>
<td>4.3.11</td>
<td>Database Dashboard</td>
<td>48</td>
</tr>
<tr>
<td>4.4</td>
<td>Database View</td>
<td>49</td>
</tr>
</tbody>
</table>

### 5 • Menu Commands

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.1</td>
<td>Introduction</td>
<td>51</td>
</tr>
<tr>
<td>5.2</td>
<td>Menu Commands</td>
<td>52</td>
</tr>
<tr>
<td>5.2.1</td>
<td>File Menu</td>
<td>53</td>
</tr>
<tr>
<td>5.2.2</td>
<td>Edit Menu</td>
<td>57</td>
</tr>
<tr>
<td>5.2.3</td>
<td>View Menu</td>
<td>63</td>
</tr>
<tr>
<td>5.2.4</td>
<td>Draw Menu</td>
<td>66</td>
</tr>
<tr>
<td>5.2.5</td>
<td>Options Menu</td>
<td>70</td>
</tr>
<tr>
<td>5.2.6</td>
<td>Database Menu</td>
<td>74</td>
</tr>
<tr>
<td>5.2.7</td>
<td>Window Menu</td>
<td>77</td>
</tr>
<tr>
<td>5.2.8</td>
<td>Help Menu</td>
<td>78</td>
</tr>
</tbody>
</table>

### 6 • Working with Objects

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.1</td>
<td>Introduction</td>
<td>79</td>
</tr>
<tr>
<td>6.2</td>
<td>CardStudio Objects</td>
<td>80</td>
</tr>
<tr>
<td>6.3</td>
<td>Resizing Objects</td>
<td>82</td>
</tr>
<tr>
<td>6.4</td>
<td>Moving and Aligning Objects</td>
<td>84</td>
</tr>
<tr>
<td>6.5</td>
<td>Editing Text Objects</td>
<td>88</td>
</tr>
</tbody>
</table>

### 7 • Working with Variables

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.1</td>
<td>Introduction</td>
<td>89</td>
</tr>
<tr>
<td>7.2</td>
<td>Variable Data</td>
<td>90</td>
</tr>
</tbody>
</table>

### 8 • About Bar Codes

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.1</td>
<td>Introduction</td>
<td>91</td>
</tr>
<tr>
<td>8.2</td>
<td>1-Dimensional Bar Codes</td>
<td>92</td>
</tr>
<tr>
<td>8.3</td>
<td>2-Dimensional Bar Codes</td>
<td>93</td>
</tr>
</tbody>
</table>
9 • Magnetic Encoding ......................................................... 95
  9.1 Introduction .................................................................. 95
  9.2 About Magnetic Stripe .................................................. 96
  9.3 Encoding a Magnetic Stripe ............................................. 97

10 • Smart Card Encoding ..................................................... 99
  10.1 Introduction ................................................................ 99
  10.2 Contact Smart Card ..................................................... 100
      10.2.1 Properties .......................................................... 100
      10.2.2 Contact Smart Card Encoding ............................... 104
  10.3 Contactless Smart Card ............................................... 105
      10.3.1 Setup ................................................................. 105
      10.3.2 Contactless Smart Card Encoding ........................... 106

11 • Overlay ...................................................................... 107
  11.1 Introduction ................................................................ 107
  11.2 Defining an Overlay .................................................... 108
  11.3 Bitmap Based Overlay ................................................. 110

12 • Logins and Passwords ................................................... 111
  12.1 Introduction ................................................................ 111
  12.2 Logins and Passwords .................................................. 112
      12.2.1 Administrator Login ............................................. 112
      12.2.2 Create User Login ............................................... 113
      12.2.3 Permissions ......................................................... 114

13 • CardStudio and Databases .............................................. 117
  13.1 Introduction ................................................................ 117
  13.2 Introduction to ODBC .................................................. 118
  13.3 Database Structure ...................................................... 120
  13.4 Data Type .................................................................. 121
  13.5 Data Source .............................................................. 122
  13.6 CardStudio Internal Database ....................................... 123
      13.6.1 Create a New Internal Database ............................. 123
      13.6.2 Working with an Internal Database ........................ 126
  13.7 CardStudio Internal Text Data Source ............................ 127
  13.8 Connect to an External Database .................................... 129
  13.9 Working with the Database Interface .............................. 130
  13.10 Database Toolbar (Database View) ............................... 132
  13.11 CardStudio Database Functions ................................... 133
  13.12 CardStudio Database Reports ...................................... 134
  13.13 Auto Print Function ................................................... 135
      13.13.1 Preparing the CardStudio for Auto Print ................ 135
      13.13.2 Start Auto Print .................................................. 136
14 • Printing ................................................................. 139
  14.1 Introduction ...................................................... 139
  14.2 Printing Process .............................................. 140
  14.3 Batch Print Process .......................................... 142
    14.3.1 Printing to a File ...................................... 142
    14.3.2 Batch Print Toolbar .................................... 144
    14.3.3 The Batch Print File Manager ......................... 145
  14.4 Print Options .................................................. 146

Appendix A • CardStudio Templates .............................. 149
Appendix B • Keyboard Shortcuts ................................. 155
Appendix C • Conditional Printing ............................... 159
Appendix D • FaceSnap .............................................. 163
Appendix E • Barcode Details ...................................... 169
Appendix F • Worldwide Support ................................. 189
1.1 Overview

CardStudio is a full-feature card design and printing software application with complete capabilities for card layout and design. It is provided in three editions: Classic, Standard, and Professional.

All three editions integrate the required features for ID Card design and production.

- **Classic**: Main application for card design and printing.
- **Standard**: Adds the ability of printing using a CSV Database connection (included with CardStudio design templates).
- **Professional**: Allows full internal database and external management via ODBC drivers as well as Contactless & Biometrics.
1.2 Features

Classic
- Full Color Design Capabilities
- Double-Sided Cards
- Image Acquisition (VFW, TWAIN, WIA, DS, FILE)
- Printing Variables (Date Time, Counters)
- Barcodes 1D - Code39, 128
- NetWork Print

Standard
- Printing Variables (Concatenation and Keyboard Input)
- Barcodes 1D/2D - Complete Library
- Clipart Manager
- Magnetic Encoding (ISO, JIS)
- CSV DB Import for Printing Only
- Network Print Server
- Barcodes 2D

Professional
- Signature Panel
- Contact Smart Card Plug-Ins
- ODBC Connectivity Microsoft Access
- DataBase Editing Window
- DataBase Reports
- Auto Print
- User Logins for Role-based Security
- Multi-Layout Card Designs
- ODBC Connectivity - All Databases
- Conditional Layout Printing from DB
- Contactless Cards (MIFARE, HID, EM Prox, TI)
- Biometric Management
1.3 CardStudio Software Versions

<table>
<thead>
<tr>
<th>Feature</th>
<th>CardStudio Classic</th>
<th>CardStudio Standard</th>
<th>CardStudio Professional</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full-color design capabilities, dual-sided cards</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Image acquisition (VFW, TWAIN, WIA, DS, FILE)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Printing variables (date time, counters)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Barcodes 1D – Code39, 128</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>CardStudio design templates and template designer</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Network print</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Barcodes 1D - All</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Magnetic encoding (ISO, JIS)</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Printing variables (concatenation, keyboard input)</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Microsoft Excel and CSV DB import</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Barcodes 2D</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Multi layout card designs</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>ClipArt manager</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Signature panel, biometric management, login security</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Contact and contactless smart card plug-ins</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>DB connectivity Microsoft Access, ODBC connectivity - all databases</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Database editing view, conditional layout printing from DB, database reports</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Network print server</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
</tbody>
</table>
2.4 CardStudio Software Overview

CardStudio is based on the use of pre-designed card templates. This greatly simplifies card design.
Create a Card
CardStudio Software Overview

Templates are organized in the following categories, though any template could be used for any particular function.

- Clubs and Associations
- ID Cards
- Other Card Designs
- Retail and Loyalty Cards
- Schools and Libraries
- Visitor Badges

The use of a card template in CardStudio allows you to choose images for predefined objects, like background and logos, as well as create new design objects over a template.

Data is stored on a spreadsheet with point-to-image-file fields (images are stored in a specific location), that can be linked to predefined objects on the card template.

All template-related files (data, image, etc.) are stored in default sub-folders within the CardStudio Program Folder:

   C:\Program Files\Zebra Technologies\CardStudio\Templates\ < category folders >

Category folders include Clubs and Associations, ID Cards, Other Card Designs, Retail and Loyalty Cards, Schools and Libraries, and Visitor Badges.

Within the category folders are sample card folders; e.g., in Clubs and Associations you will find Adventurepass, CountryClub, Skipass, etc. Each sample card folder is structured as follows:

- ...
  - ...
    - ...
      - ...
        - ...
          - ...
            - Backgrounds (Landscape or Portrait)
            - ...
              - ...
                - Card Template (Adventurepass.car file)
2.5 Build a Card

2.5.1 Run CardStudio

1. Click on the CardStudio desktop icon. Note that the icon was automatically placed on the desktop when CardStudio was installed.

2. The CardStudio splash screen will briefly display.

3. View the initial template-selection screen.
2.5.2 Pick a Template (pre-designed card)

1. Select the desired Template Type from the drop-down menu; e.g., Clubs and Associations.

2. Click on the desired template (circled above) to select it.

3. Click on the Select button.

4. The selected template will open in Design View.
2.5.3 Modify Template Objects

Examine the selected template in Design View.

2.5.3.1 To change the background:

1. Click on the Design option on the Dashboard.

2. View the various backgrounds in the thumbnail display area.

3. Select a new background by clicking on the thumbnail (circled below).

4. The new background will replace the old background.
2.5.3.2 To position the objects on the card:

Note • See Section 6, Working with Objects, for information on objects, their properties, and how to edit them.

1. Manually position the objects (text boxes, images, etc.) via the drag-and-drop method.

2. Align selected objects (text boxes, images, etc.) via the Alignment Tool.

3. Align the text within the text boxes (left, center, right, etc.) via the Position option on the Dashboard.

4. Apply text attributes (font, size, color, etc.) via the Text option on the Dashboard.
2.5.3.3 To change text:

Text in the pre-designed text boxes can be changed via the **Design** option on the Dashboard.

Simply enter the text in the appropriate field; e.g., *CompanyName* circled above.

**Note** • Text can also be edited or replaced by selecting the text directly.
2.5.3.4 **To change the Company Logo:**

The Company Logo can be changed via the **Design** option on the Dashboard.

1. Click on the *Get Logo* button.

2. Browse to and select the new logo you want to import, and click on the *Open* button.

3. If necessary, re-position and/or re-size the logo.
   - To re-position the logo, simply drag-and-drop the image to the new location.
   - To resize the logo, click and drag a sizing handle until the outline of the logo is the right shape and size. To resize but keep the proper ratio, hold the Shift key.
2.5.3.5 **To add a fixed image:**

A fixed image is repeated on every card (similar to the Company Logo).

1. On the Drawing toolbar, click the Image Drawing Tool; the pointer will change to a hand with an Image Icon.

2. Move the pointer to the location on the card where you want to place the the upper left-hand corner of the image.

3. Press and hold the left mouse button, and drag from left to right. As you drag, an image frame forms. Continue dragging until the frame is the desired size.


5. Browse to and select the image you want to import (circled above), and click on the *Open* button.

6. If necessary, re-position and/or re-size the image.
2.5.3.6  To add, edit, or delete data file elements:

Note • See Section 13, CardStudio and Databases, for details on database functions.

A data file element contains data that is linked to a data file and changes on every card.

1. Drag-and-drop the desired field (e.g., First Name) from the Database option on the Dashboard into your card; then position and size the text box.

2. Align the text (left, center, right, etc.) via the Position option on the Dashboard.

3. Apply text attributes (font, size, color, etc.) via the Text option on the Dashboard.

Note • The ID Photo is not considered a fixed image. It is a variable element created at the time of card issuance or printing; see Section 2.6.5, Take a picture with the camera on page 22 to add a photo as part of the card creation process.
2.5.3.7  To add a Bar Code:

**Note** • See Section 8, About Bar Codes, for details on bar code standards and symbologies.

The following steps show how to add a bar code to your card using an existing database field; in this example, the Expiration Date.

1. On the Drawing toolbar, click the Bar Code Tool; the pointer will change to a hand with a Bar Code Icon.

2. Move the pointer to the location on the card where you want to place the upper left-hand corner of the image.

3. Press and hold the left mouse button, and drag from left to right. As you drag, a rectangle forms. Continue dragging until the rectangle is the desired size.


5. Click on the OK button.

7. Select the **Bar Code** option on the Dashboard.

   a. From the Style drop-down menu, select the desired bar code format.
   b. Mark the desired field attribute checkboxes.

8. Select the **Source** option on the Dashboard.

   a. From the drop-down menu, select the Source; e.g., Database Source. The Select Column dialog box will appear.

   b. Select the desired data field; in this example, the Expiration Date.
   c. Click on the *Finish* button.
9. If necessary, re-position and/or re-size the Bar Code.

2.5.4 Save the Template as Your Card Design

Use the Save As... command (from the File menu) to save the template as your card design.

1. File > Save As...

2. View the Save dialog box.

3. Choose a file name and location where your card design will be stored. Note that the default storage location for cards is the Card folder in the CardStudio program files directory.

To save a document previously named and with its location defined, use the Save command from File menu or the Ctrl +S shortcut.
2.6 Print Cards

Note • See Section 14, Printing, for details on the printing process and the print manager.

2.6.1 Locate and open your card design

1. File > Open...

2. From the Open dialog box, locate and select your card design.

3. Click on the Open button.

4. Examine your card design in Design View.
2.6.2 Switch to Database View

1. Select the Database View (click on the View button to change from the Design View to the Database View and vice versa).

2. Review the database record(s).
2.6.3 Add a new record

1. Click on the *Add Record* icon on the toolbar. A new data-entry screen will appear.

2. Enter data as required.

3. To add a picture, go to page 22; otherwise, click on the *Save Record* icon.
2.6.4 One-time camera setup

Complete the following steps the first time the camera is installed or used.

1. Click on the Options icon on the toolbar, then select Imager Settings.

2. View the Imager settings window.

3. In the Source Type drop-down menu, select DirectShow.

4. In the Available Sources drop-down menu, select USB Video Device.

5. Click on the Test button to verify that the camera is working.

6. Click on the Close Window button.

7. Click on the OK icon.
2.6.5 Take a picture with the camera

1. Click on the **Live Image** button.

2. Preview the image in the Imager.

3. Click on the **Take Picture** button.

4. Preview the image:
   a. If the image in the preview window is OK, go to Step 5.
   b. Otherwise, click on the **Live Image** button, and go to Step 2.

5. Click on the **OK** button.

6. When finished, click on the **Save Record** icon.

7. The image is added to the database record and is displayed as a Live Image thumbnail.
2.6.6 Print the card

1. Use the Card Print... command (from the File menu) to print your card design.
   a. File > Card Print...
   b. View the Card Print/Process dialog box.

   ![Card Print/Process dialog box]

   c. From the Destination drop-down menu, select the printer driver.
   d. Make the appropriate Operations, Layout, Print Range, and Copes selections.
   e. Click on the OK button.

2. The card will be printed. Printing time time will vary depending on the complexity of the card design and the processing speed of the computer.

3. Once the printing is completed, the card is ejected into the printed card hopper.

4. Remove the card from the card output hopper, and check for any discrepancies. If the card is correct, your printer is ready to produce more cards.
3

Toolbars

3.1 Introduction

This section summarizes all the toolbar commands: Design, Drawing, Database, and Batch Print.

You can use Toolbars for quick access to some of the most commonly used commands and tools. Tool tips explaining the functions of each button are displayed if you hold the mouse pointer over the desired button.

Depending on the CardStudio version/edition some menu items may be not available.

Note: You must use a mouse to choose buttons on the Toolbars. You cannot use the keyboard.
3.2 Design Toolbar (Design View)

Design buttons are located across the top of the CardStudio window.

**Design Toolbar**

- **View**: change from Database View into Card Design View.

- **DB Open / Close**: connect / disconnect from the Database.

- **Magnetic Encode**: specify Magnetic Encoder properties.

- **Contact Smart Card**: specify Contact Smart Card properties.

- **Contactless Smart Card**: set up Contactless Smart Card.

- **Overlay Varnish**: specify Overlay properties.

- **Grid**: show / hide the Grid.

- **Front Card**: view front card layout.

- **Back Card**: view back card layout.

- **Zoom In**: zoom in the document; magnifies the size of the card depicted on the screen.

- **Zoom Out**: zoom out the document; reduces the size of the card depicted on the screen.

- **Zoom**: zoom the document to the size of the workspace.

- **Print**: print the current card.
3.3 Drawing Toolbar (Design View)

Drawing buttons are located along the left-hand side of the CardStudio window.

**Drawing Toolbar**

- **Object Selector**: select an object.
- **Line Drawing Tool**: add a horizontal, vertical, or diagonal line.
- **Rectangle Drawing Tool**: add a rectangle.
- **Ellipse Drawing Tool**: add an ellipse.
- **Text Drawing Tool**: add text.
- **Bar Code Drawing Tool**: add a Bar Code.
- **2D Bar Code Symbol Drawing Tool**: add a Bar Code 2D.
- **Image Drawing Tool**: add an image.
- **Image with Video Source object**: enable an imager to capture a video source object.
- **Image with Scan Source object**: enable an imager to capture a scan-source object.
- **Biometrics object drawing tool**: enable a biometric enrolment via a Biometrics Terminal.
- **Signature Pad object**: place a signature pad object on the card.
- **Alignment**: align multiple selections of objects on the card.
- **Distribute Objects**: distribute three or more objects on the card.
3.4 Database Toolbar (Database View)

Design buttons are located across the top of the CardStudio window.

**Database Toolbar**

- **View**: change from Database View into Card Design View.
- **DB Open / Close**: connect / disconnect from the Database. Note that the icon turns red when disconnected from the Database.
- **Database Properties**: edit Database properties.
- **Define View**: arrange the Database view as you wish; i.e., change the order of the fields.
- **Back**: go to the first record on Database.
- **Back**: go to the previous record on Database.
- **Add**: add record to Database.
- **Save**: save record / data on Database.
- **End of Fields**: if selected in Database properties, allows to execute the "end of fields" operations at any moment.
- **Remove**: remove record from Database.
- **Forward**: go to the next record on Database.
- **Forward**: go to the last record on Database.
- **Print**: print the current card.
3.5 Batch Print Toolbar

To access the Batch Print Toolbar, select File > Batch Print File Management. In the browse window, find and select the desired batch print file.

Batch Print buttons are located along the top of the CardStudio window.

**Batch Print Toolbar**

- ![Symbol](image1.png) Sets the card status to Print. Cards marked with this symbol are ready to print.

- ![Symbol](image2.png) Sets the card status to Error. If an error occurs while printing, the card marked is with this symbol.

- ![Symbol](image3.png) Sets the card status to Printed. Cards marked with this symbol were printed properly.

- ![Symbol](image4.png) Sets the card status to Held. Cards marked with this symbol are excluded from printing.

- ![Symbol](image5.png) Switches between Front and Back view.

- ![Symbol](image6.png) First card.

- ![Symbol](image7.png) Previous card.

- ![Symbol](image8.png) Next card.

- ![Symbol](image9.png) Last card.

- ![Symbol](image10.png) Prints the selected status.

- ![Symbol](image11.png) Close.
4.1 Introduction

The main CardStudio window, with its accompanying toolbars and menus, closely resembles the windows you work in for other Windows-based programs. You will be working in the main window (and its sub-windows) as you design and print your cards.
4.2 Design View

All your work to layout a card is done in the Card Work Area. This area displays a card outline. Any objects placed outside the card borders will not be printed.

♦ **Design Toolbar**: Design buttons are located across the top of the CardStudio window; see Section 3.2 for details.

♦ **Drawing Toolbar**: Drawing buttons are located along the left-hand side of the CardStudio window; see Section 3.3 for details.

♦ **Title Bar**: The Title Bar displays the name of the CardStudio program and the name of the active card file.
  - Minimize, Maximize Button: Using the mouse, you can click the Maximize button to enlarge the active program window so that it fills the entire desktop, or you can click the Minimize button to reduce the window to an icon.
  - Restore Button: Using the mouse, you can click the Restore button to resize a window to its previous size and location.
  - Close Button: Using the mouse, you can click the Close button to end your CardStudio session.

♦ **Close Window Button**: The Close Window Button (in the top right of CardStudio interface) closes the window (with the document) of CardStudio without quitting application.

♦ **Menu Bar**: The Menu Bar lists the available menus. A menu contains a list of commands, or actions, you can carry out with the CardStudio.

♦ **Rulers**: Rulers can be configured to display inches or centimeters. Set your unit of measure via Options Menu > Metrics. To display the rulers, choose Rulers from the View menu. To hide the rulers, choose Rulers from the View menu again.

♦ **Grid**: An invisible network of lines covering the card. As you draw objects, they will co-interact with the grid, if Snap To Grid is checked in the Grid Settings Dialog box (Options Menu). You can turn it on and off using the Grid command from the View menu.

♦ **Cross Hair**: The Cross Hair represent the cursor position within the card document. You can turn it on and off using the Cross Hair command from the View menu.

♦ **Standard Status Bar**: Messages appear at the bottom of the window in areas called Status Bars. These messages describe what you are seeing and doing in the CardStudio window as you work. The Status Bar displays the x and y coordinates of the pointer, and the type, location, and size of the currently selected card object. Displays also the name of the tool when selecting the tool’s button and when you choose a command provides a short message telling you what that command will do.
Screen Setup:

- The command Cross Hair from the View menu toggles the cross hair cursor.
- Using the command Grid on the View menu you can, display or hide the layout grid (CTRL+G).
- Use the Grid Settings command from the Options menu to control snap to grid; show / hide grid and grid spacing.
- Using the command Guidelines on the View menu you can, display or hide the card-edge guidelines (CTRL+L).
- Using the command Rulers on the View menu you can, display or hide the rulers layout. Use the Rulers Settings command from the Options menu to control the rulers behavior. Use the
- Metrics command from the Options menu to change the measurement unit.
- Use the Object Tooltips from the View menu to display a brief description of the object. A Tooltip is displayed when the mouse pointer rests over the object.
- Zooming the Card Image
  - The size of the card image can be changed by using the Zoom In (+) and Zoom Out (-) commands on the View menu. Exact placement of objects on the card is sometimes easier if the image is larger.
  - Using the command Fit Workspace on the View menu, you can display the entire card page.

  Zoom In Button:

  Zoom Out Button:

- User Metrics: From the Options menu select the command Metrics. Choose between millimeters or inch. All measurements are displayed in the selected unit.

Shortcut Keys

- You can choose some commands by pressing the keyboard Shortcut Keys listed on the menu to the right of the command.
- The CardStudio uses many of the Shortcut keys found in other Windows programs.
- See Appendix B, Keyboard Shortcuts, for details.
♦ Working with Commands:

A Command is an instruction that tells the CardStudio to perform an operation. The CardStudio provides several ways for you to choose commands. You can choose commands from a menu or toolbar, or you can use shortcut keys.

- Toolbar Commands: The CardStudio Toolbars provide you with one-step access to lots of tasks. You can draw a rectangle, place a photograph, define a bar code, edit text and much more - all with just one click of a mouse button on one of the CardStudio tools.

- Menu Commands: Commands are grouped in menus. Some Commands carry out an action immediately; others display a dialog box so that you can select options. You’ll know that a Command will display a dialog box, if it is followed by three periods (...).

- Mouse Shortcuts: You can use a Mouse Shortcut to give you quick access an object’s property sheet (see Object Properties menu: on page 35) or to display a shortcut menu (see Shortcut menu: on page 36).
Object Properties menu:

To display an object’s property sheet, point to the object, click the right mouse button, observe the Object Properties menu, and choose the property you want to apply.

<table>
<thead>
<tr>
<th>FUNCTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust Bounding</td>
<td>Fit an object’s size when applicable; e.g., after writing some text, you may use this command to adjust and fit the text box size.</td>
</tr>
<tr>
<td>Fit to Card</td>
<td>Fit some objects to a card; e.g., draw a square shape, select the Fit to Card command, and the square shape will be transformed to fit the card size.</td>
</tr>
<tr>
<td>Send to Front</td>
<td>Move an object to the front (to be the first selectable item) of another one.</td>
</tr>
<tr>
<td>Send to Back</td>
<td>Move an object behind (to be the last selectable item) of another one.</td>
</tr>
<tr>
<td>Set as Background</td>
<td>Fit some objects as card background; e.g., select an image, select the Set as Background command and the image will be transformed to fit the card size.</td>
</tr>
<tr>
<td>Save Image as ...</td>
<td>Save the selected image in a different file format; e.g., <code>&lt;filename&gt;.bmp</code> to <code>&lt;filename&gt;.jpg</code>.</td>
</tr>
<tr>
<td>Paste</td>
<td>Place an object in the clipboard on the card.</td>
</tr>
<tr>
<td>Cut</td>
<td>Remove objects from card and place them in the clipboard. The object will remain in the clipboard until you cut or copy another one.</td>
</tr>
<tr>
<td>Copy</td>
<td>Place objects in the clipboard to use later with the Paste command.</td>
</tr>
<tr>
<td>Duplicate</td>
<td>Duplicate an object on the card; i.e., copy and paste in one operation.</td>
</tr>
</tbody>
</table>
Shortcut menu:

To display the **Shortcut menu** when you have no objects selected, move the mouse pointer to a place not on an object, click the right mouse button, observe the shortcut menu, and choose the action you want to perform.

<table>
<thead>
<tr>
<th>FUNCTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paste</td>
<td>Place an object in the clipboard on the card.</td>
</tr>
<tr>
<td>Select All</td>
<td>Select all the objects on a card.</td>
</tr>
<tr>
<td>Export to Image</td>
<td>Export your whole card as an image. With this command, you do not export an object but the whole document. After selecting the command, you will be prompted to save the card in one of the various file formats.</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Enlarge the view of everything on the page.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Reduce the view of everything on the page.</td>
</tr>
<tr>
<td>Show Gridlines</td>
<td>Show or hide the two gridlines at each of the four corners of the card.</td>
</tr>
<tr>
<td>Show Grid</td>
<td>Show or hide the grid on the card. When enabled, the grid overlays the image and makes it easier for you to line up selected objects</td>
</tr>
<tr>
<td>Grid Settings...</td>
<td>Edit grid settings: show / hide grid, snap to grid, and grid spacing (.horizontal and vertical).</td>
</tr>
<tr>
<td>Ruler Settings...</td>
<td>Edit ruler settings: show / hide rulers and show / hide item selection on rulers.</td>
</tr>
<tr>
<td>Edit Background</td>
<td>Edit the background via the Imager.</td>
</tr>
<tr>
<td>Delete Background</td>
<td>Delete the background.</td>
</tr>
</tbody>
</table>
4.3 Dashboard

The Dashboard is an innovative way for you to edit some objects properties. It is fast, intuitive, and saves time looking for information on how to do simple operations.

Full Screen:

Detail:
4.3.1 Source Dashboard

Source Dashboard allows you to manipulate (acquire, set properties, and edit) a single, selected object.

- **Properties** button lets you edit object properties.
- **Get** button lets you get a new object.
- **Edit** button opens the Imager which allows you to edit the selected object.
- **Edit After Acquire** checkbox allows you to choose to edit an image immediately after acquisition.
- **Acquire on print** checkbox acquire image source on print.
- **Display Only** checkbox only shows selected object on screen and will not be printed if this option is activated. It works with all kind of objects.
- **Protected** checkbox protects object from being selected and edited thereby preventing future modifications. It works with all kind of objects.
- **Silent Mode** checkbox defines that image acquisition will be made in silent mode, so the Imager will not pop-up for the user to make selections and edition.
- **Variable Name** allows you to edit the variable name of the object selected on the card.
4.3.2 Position Dashboard

Position Dashboard allows you to manipulate (position, size, align, and rotate) a single, selected object.

- **Position** shows the actual horizontal and vertical position of an object.
  - Horizontal position: allows you to adjust the object’s horizontal position.
  - Vertical position: allows you to adjust the object’s vertical position.

- **Size** shows the actual horizontal and vertical size of an object.
  - Horizontal size: allows you to adjust the object’s horizontal size.
  - Vertical size: allows you to adjust the object’s vertical size.

- **Align** only works with Text, Bar Code, 2D Bar Code, and Image objects.

- **Rotation** allows you to set an object’s rotation to 0°, 90°, 180°, or 270°.
4.3.3 Line Dashboard

Line Dashboard lets you customize your objects borders such as text box or graphic images (line, ellipse, rectangle, and text).

- **Color**: Choose line color from the dropdown menu.
- **Black Panel**: Enable the Black Panel option.
- **Thickness**: Choose the thickness of your lines (0.2mm - 3 mm).
- **Style**: Select the line style (solid and dash patterns) from the dropdown menu.
4.3.4 Fill Dashboard

Fill Dashboard allows you to color the fill of some objects (ellipse, rectangles and text) with one color, gradient, or Black Panel.

- **Color 1**: To use one color for the background of your object, disable the Black Panel and Gradient Fill options; and select your color from the Color 1 dropdown menu.

- **Color 2**: See Gradient Fill below.

- **Black Panel**: Choosing Black Panel will automatically change the object fill into black and disable the color selectors.

- **Gradient Fill**: To use Gradient Fill select Gradient Fill button and choose 2 colors from the Color 1 and Color 2 selectors. The result will be a combination of defined colors with degrade transition in the Horizontal or Vertical direction.
4.3.5 Text Dashboard:

Text Dashboard allows to define text properties such as Font, Size, Bold, Italic, Underline, Color, Black Panel (using Black Panel will disable the Color selector), and Negative.

- **Multiline** allows text in more than one line.
- **Word Wrap** is an option when Multiline is selected and shows all text in the text box.
- **Shrink to Fit** will fit text in text box when Word Wrap is disable.
- **Lowercase** changes text to "aaa".
- **Uppercase** changes text to "AAA".
- **Capitalized** changes text to "Aaa Bbb Ccc".
- **Preview as Image** is *Not Applicable*, should always be unchecked.
4.3.6 Image Dashboard:

Image Dashboard allows you to make some simple changes to an image.

- **Stretch** transforms images without losing original aspect.
- **Auto Face Recognition** crops the image to the face. Used with *Face Snap* and an image from the database on the card area. *Face Snap* setup determines cropping parameters.
- **Manual Crop** enables preview image to select and cut.
- **Crop to Bounding Ratio** enables the preview image to be cropped without losing the original ratio.
- **Black Panel** prints the selected image with the black panel. The image will be dithered according to the settings in the *Monochrome Conversion* option; see Section 5.2.5.
- **Cut Out Color** allows you to selectively remove a color from an image. The color range is determined by the tolerance level defined by the user. To remove a color:
  1. Select the Cut Out Color checkbox.
  2. Click on the eyedropper icon below the checkbox. The cursor will change to an eyedropper.
  3. In the selected image, click on the color you want to remove. The selected color will be displayed in the box adjacent to the eyedropper icon.
  4. Adjust the Tolerance slider until the desired amount of the selected color has been removed from the image.
  5. When satisfied with the color removal, de-select the image.
4.3.7 Effects Dashboard

The Effects Dashboard allows you to enable effects on selected objects: lines, ellipses, rectangles, text, and images.

- **Transparency** ranges from 0 to 100 percent.
- **Rounded Corners** ranges from 0 to 359 degrees.
- **Reflection** with degrade to transparency (arrow below). Simply select the Reflection checkbox to implement the reflection feature.
4.3.8 Bar Code Dashboard

The Bar Code Dashboard allows you to edit bar code properties.

- **Style** allows you to select the bar code type and specify various properties.
  - The dropdown menu that allows you to select the type of barcode; e.g., Code 93, EAN/JAN-13, UPC-A, etc.
  - **Human readable** and **Show Check Digit** are properties selectable via checkboxes.

- **Ratio**, **Check Sum**, and **Additional Digits** are customizations available for the selected bar code.
### 4.3.9 2D Bar Code Dashboard

2D Bar Code Dashboard appears when a 2D Bar Code is created.

![2D Bar Code Dashboard Image](image)

- **Style** allows you to select the bar code type and specify various properties.
  - The dropdown menu allows you to select the type of barcode; e.g., PDF 14, Aztec, RSS, etc.
  - **Horizontal Resolution**, **Vertical Resolution**, etc., are customizations available for the selected bar code.

- **Reduce Width, Reduce Height, etc.**, are properties selectable via checkboxes.
4.3.10 Clip-Art Dashboard

Clip-Art Dashboard allows you to manage your library of clip-art.

♦ To drag-and-drop an image, simply click on the thumbnail; and drag it onto card.
4.3.11 Database Dashboard

The Database Dashboard provides Database navigation. It is a simple way to drag-and-drop contents into card direct from Database.

♦ By default, you are not connected to a database. You need to connect to a Database by clicking on Connect in the Database Menu.

♦ To drag-and-drop an object, simply click on item title; and drag it into card.
4.4 Database View

Displays all data field names and provides a field to enter or edit data for the current Database. You need to be connected to Database to edit/view entries.

♦ **Database Toolbar**: Database buttons are located across the top of the CardStudio window; see Section 3.4 for details.

♦ **The Horizontal Split Window**: Used to separate horizontally the Record View from the Browse View. The split window can be sized with the mouse.

- **Record View**: The Record View (on Database Window) allows you to edit records in the Database.

- **Browse View**: The Browse view displays the Database records when connected to the Database. This view allows the user to Select, Find, and Seek records in the Database.

  o Use **Seek** by choosing a Database Field, and type the characters that match the text you want to find on the selected field. Current record will be automatically repositioned.

  o Use **Select by** choosing a Database Field, using Starting With or Containing operator and the text you want to use on your simple query, press the Apply button (checkmark) to get a smaller list of records.

  o Use **Find On** choosing a Database Field, using Starting With or Containing operator, the text you want to use, and the Apply button (checkmark) to find a record matching your request.
Main Window
Database View

♦ The Dashboard

- **Card Preview** shows the card while you are working on it.

- **Record Selection** allows the user to create and execute record selection instructions (queries) by using the simple drop-down fields to define the query conditions or by editing the conditions directly on the text box.

- **Encoding** enables Processing and Reading operations directly from the database view, as well as defining the Card Serial Number storing condition.
5

Menu Commands

5.1 Introduction

This section summarizes the commands available in the CardStudio menus. Depending on the CardStudio version/edition some menu items may be not available.

File Menu ................................................................. 53
Edit Menu ................................................................. 57
View Menu ................................................................. 63
Draw Menu ................................................................. 66
Options Menu ............................................................. 70
Database Menu ............................................................ 74
Window Menu ............................................................. 77
Help Menu ................................................................. 78
5.2 Menu Commands

Full Screen:

Detail:
5.2.1 File Menu

♦ New

New command creates a new card document. You can also use Ctrl + N shortcut to create a new card document.

♦ Open

Open... command opens an existing card document. You can also use Ctrl + O shortcut to open an existing card document.

♦ Close

Close command closes the CardStudio application.

♦ Save

Save command saves the card document in actual location, previously named with Save As... command. You can also use Ctrl + S shortcut with the same purpose as Save command. To choose a different name and / or a new location use Save As... command from File menu.

♦ Save As

Save As... command opens the Save dialog box where it is possible to choose a file name, type of document, and location where card document will be stored. To save a document previously named and with its location defined, only need to use the Save command from File menu or Ctrl + S shortcut.
Menu Commands

♦ Card Setup

Select a card orientation. When you change the orientation of a card, CardStudio transfers the Top and Bottom margin measurements to the Left and Right margin measurements and vice versa.

Card Size: allows you to select the size of media (card) on which you are printing. Click on the Card Size down arrow. A list of card size selections will appear. Select the card size option that is appropriate for the media size you are using.

Special Note: This option is only available via driver.

Click Print Self-test to send a test card to your printer. You might want to do this to make sure your printer is set up correctly.

♦ Card Print

To print a card select one of the following methods:

- Select Card Print... command.
- Click on Print button from Design Toolbar.
- Use Ctrl + P shortcut.

Card Print/Process dialog box:

![Card Print/Process dialog box](image)
Destination

Identifies the active printer.

Lets you select another printer from the dropdown menu.

Click the Properties button to display the printer properties (dialog box).

Send to Batch Print Manager: prints the job into a batch print file.

Print As Image: prints the job as an image.

Operations

You can combine the different operations to better suite your needs.

- Print: print a card.
- Magnetic Encode: encode a card.
- Hologram: print hologram ribbon.
- Contact Smart Card: start the Smart Card process.
- Contactless Smart Card: encode contactless smart cards.
- Biometrics: activate the biometrics to acquire a fingerprint.

Select the operation you want to perform from the dropdown list (only available when connected to a database).

Layout

- Print Front: print the front card layout.
- Print Back: print the back card layout.
- Flip on Long Edge: reverse the back side of the card, when printing both sides of the card.
- Rotate 180 Degrees: rotate all the card items 180 degrees, this option is available for front and back card layout.
- Select ribbons: select ribbons to be used.

Print Range

You can ask for a single or multiple printing.

For a multiple printing choose the Multiple option and write the number of cards you want to print.
Menu Commands

Copies

Number of copies: type or select the number of copies you want to print.

Database

- Number of records: type or select the number of records to print.
- Print All: check this option to print all records.
- Print Selected: check this option to print the selected records.

If the option Keep Database Position isn’t checked the record displayed after a database print process is the record next to the last printed.

♦ Email Card

Email Card command opens a Dialog Box where you can specify front and/or back card images. When you click on the Send button, a new message is opened in your your default email service with the card image(s) attached.

♦ Logins

Logins... command opens a Dialog Box where you can change, create, and delete users logins.

- Click Edit button to change users login information (user identification; login name; password and permissions).
- Click New button to create a new user login.
- Click Remove button to delete a user login.

Enable Login Control: check this option to enable logins when you start CardStudio.

♦ Batch Print File Management

Batch Print File Management... command opens the Select Batch Print File Dialog Box, which allows you open an existing batch file.

Instead of printing a document, you can create a batch file, which contains the document you want to print. You can then print the card document at a later time.

♦ Exit

Exit command closes the CardStudio application. CardStudio will prompt you to Save a document if you choose this command without saving your work.
5.2.2 Edit Menu

♦ Undo

Use Undo command to cancel and to step back till 6 operations. When you do your first Undo operation it will enable automatically Redo option from same menu.

You can also use the Ctrl + Z shortcut for faster Undo operation.

♦ Redo

Use Redo command to replace objects or remake operations undone with Undo command. It is possible to recover up to 6 operations.

You can also use the Ctrl + Y shortcut for faster Redo operation.

♦ Cut

Use Cut command (from the Edit menu) to remove objects from card and place them in the clipboard. The object will remain in the clipboard until you cut or copy another one.

You can also use one of the following methods to cut objects:

- Select object and use Ctrl + X shortcut;
- Select object and use Ctrl + Del shortcut.
Menu Commands

♦ Copy

Use Copy command to place objects in the clipboard to use with Paste command.

You can also use Ctrl + C shortcut for Copy operation.

♦ Paste

Use Paste command to use objects from clipboard on card.

You can also use Ctrl + V shortcut for Paste operation.

♦ Duplicate

Duplicate command is an useful tool to duplicate objects on card. You just need to select the object you want to duplicate and use the command to complete operation or use Ctrl + D shortcut.

♦ Export to Image

Export to Image... command lets you export your whole card as an image with some options enabled. With this command you do not export an object, but the whole document. After selecting the command, a Save As Dialog Box will open to prompt you to save a card in one of the following formats:

- Bitmaps (*.bmp)
- JPEG documents (*.jpg)
- PCX documents (*.pcx)
- TIFF documents (*.tif)
- TGA documents (*.tga)
- GIF documents (*.gif)

When you Export to Image your card layout to a .jpg format, another Dialog Box will appear to let you adjust the image quality with a slide bar.

♦ Select All

Select All command lets you Select All objects in a card.

You can also use Ctrl + A shortcut to Select All objects.
♦ Adjust Bounding

Adjust Bounding command allows you to fit an object’s size when applicable.

You can also use F2 shortcut to use Adjust Bounding command.

Example: Use the text button (from Drawing Toolbar) to write some text without resizing the text box. After writing the text, use Adjust Bounding command to adjust and fit the text box size.

♦ Fit to Card

Fit to Card command adjusts the size of the object to fit the card.

You can also use Ctrl + Shift + F shortcut to apply Fit to Card command.

Example: Design a square shape. Use Fit to Card command, and the square shape will be transformed to fit the card size.

♦ Send to Front

Send to Front command allows to bring to front (to be the first selectable item) an object behind another one.

You can also use Ctrl + F shortcut to use Send to Front command.

♦ Send to Back

Send to Back command allows to Send to Back an object to be behind of another one.

You can also use Ctrl + B shortcut to use Send to Back command.
♦ Align

Align command allows you to align two or more objects on card.

1. To align objects, first select them; and then use the Align command or Align button from Drawing Toolbar.

2. Then another Dialog Box will appear with the buttons for you to manage the objects on the card.
Distribution

Distribution command allows you to distribute three or more objects on a card.

1. To distribute objects, first select them and then use the Distribution command or Distribution button from Drawing Toolbar.

2. Then another Dialog Box will appear with the buttons for you to manage the objects on the card.
Menu Commands

♦ Object Properties

Use Object Properties command to display the selected object property sheet. You can also use Alt + P shortcut to use Object Properties command.

♦ Use Private Clipboard

Use the Private Clipboard command to use only the CardStudio clipboard. CardStudio lets you choose between using only CardStudio clipboard or all Window's applications clipboard. If you choose Use Private Clipboard command you will be only able to Copy and Paste objects inside CardStudio application.

♦ Use Window's Clipboard

Use Window's Clipboard command to use all Window's applications clipboard. CardStudio lets you choose between using all Window's applications clipboard or only CardStudio clipboard. If you choose Use Window's Clipboard command you will be able to Copy and Paste objects from all Window's applications clipboard.

♦ Manufacturer Keys

Manufacturer Keys... command lets you edit CardStudio Manufacturer Keys:

• Add key pair
• Remove key pair
• Update Manufacturer Keys File

♦ Predefined Names List Editor

Predefined Names List Editor... command allows to add variable names to list. To add variable names to list, type the name in input box; click the **Add variable name to list** button; and then click the **Apply** button.
5.2.3 View Menu

♦ Card Front

Card Front command allows to change Card position on screen from back into front.

You can also use Ctrl + 1 to use Card Front option.

Switching objects position (from front into back and vice-versa)

If you want to move an object to the other side of the card, in this case from back to front, simply select the object you want to move and then choose the command Card Front and a Dialog Box (Card Side Switching) will appear asking your for one of the following operations:

- Move selected objects to the other side;
- Don't move any object;
- Check box: Don't prompt again: use always this behavior.
Menu Commands

♦ Card Back

Card Back command allows to change Card position on screen from front into back.

You can also use Ctrl + 2 to use Card Back option.

Switching objects position (from back into front and vice-versa)

If you want to move an object to the other side of the card, in this case from front to back, simply select the object you want to move and then choose the command Card Back and a Dialog Box (Card Side Switching) will appear asking you for one of the following operations:

• Move selected objects to the other side.
• Don't move any object.
• Check box: Don't prompt again: use always this behavior.

♦ Zoom In

Zoom In command Zooms in card document.

You can also use one of the following methods to Zoom In a document:

• Use the + shortcut.
• Mouse right click and choose Zoom In from shortcut menu.

♦ Zoom Out

Zoom Out command Zooms Out card document.

You can also use one of the following methods to Zoom Out a document:

• Use the - shortcut.
• Mouse right click and choose Zoom Out from shortcut menu.

♦ Fit Workspace

Fit Workspace command (from the View menu) fits card on screen.

♦ Preview Mode

Preview Mode command shows card in Preview Mode while you are working on it. When this option is checked, Grids and Guidelines will not appear on card as well as bounding boxes around objects.
♦ Object Tooltips

Object Tooltips command will show or hide object information when mouse rollover. The information displayed are type of object and dimensions.

♦ Rulers

Rulers command shows or hides the rulers on card.

♦ Guidelines

Guidelines command shows or hides Guidelines on card, an instrument that delimits the printable area on card.

You can also use Ctrl + L to show or hide Guidelines.

♦ Grid

Grid command shows or hides Grid on card.

You can also use Ctrl + G to show or hide Grid on card.

♦ Cross Hair

Cross Hair command shows or hides Cross Hair on screen.

♦ Show Bounding Boxes

Show bounding boxes command enables or disables bounding boxes around objects.

♦ Database Layout

Database Layout command changes the CardStudio View from Card Layout into Database Layout.

To do the same operation, you can also use the View Button from the Design Toolbar.
5.2.4 Draw Menu

♦ Selector

Selector command allows to:

- Select an object: click over the object with the left mouse button.
- Move an object: click and hold the left mouse button over it and move the object to the other place. To complete operation release the left mouse button.
- Resize an object: select the object, click and hold the left mouse button over one of the object selector corners, and drag it to desired size. To complete the operation release the left mouse button. Note that to resize but keep the proper ratio, hold the Shift key.
- Edit an object: right-click over it to open object properties menu.

You can also use Shift + S to activate Selector tool.

♦ Line

Line command draws straight lines over the card that can be edited only on its size.

To draw lines over the card with different angles use one of the following methods:

- Use Shift + L and left-click with mouse over card layout and move around. To complete operation release the left mouse button.
- Click on Line Button from Drawing Toolbar and then mouse left-click on card to draw line.
♦ Shapes

Shapes... command opens a menu with 2 shapes tools available:

Rectangle: create rectangles. Shift + R

Ellipse: create ellipses. Shift + E

♦ Text

Text... command from (Draw menu) creates text boxes where you are able to add text. After choosing Text... from Draw menu, double-click on the text selected box to enable text cursor and add text.

To add text you can also use one of the following methods:

• Use Shift + T shortcut, then mouse left-click and drag to other place.
• Use Text Button from Drawing Toolbar, then mouse left-click and drag to other place.

♦ Bar Code

Bar Code... command opens a Bar Code Value dialog box where you can enter a Value (numbers or capital letters). Click Ok to complete operation. See Section 8, About Bar Codes, for details.

To add a Bar Code you can also use one of the following methods:

• Use Shift + U, then left-click and drag to other place. The Bar Code Value dialog box will appear. Enter the Value, and click Ok or Cancel to complete operation.
• Use the Bar Code button from Drawing Toolbar, then left-click and drag and drop the cursor. The Bar Code Value dialog box will appear. Enter the Value, and click Ok or Cancel to complete operation.

♦ 2D Bar Code

2D Bar Code command opens a Bar Code Value dialog box where you can enter Data to Encode. Click Ok to complete operation. See Section 8, About Bar Codes, for details.

To add a 2D Bar Code you can also use one of the following methods:

• Use Shift + P shortcut, then left-click and drag and drop the cursor. The Bar Code Value dialog box will appear. Enter the Data to Encode, and click Ok or Cancel to complete operation.
• Use the 2D Bar Code button from Drawing Toolbar, then left-click and drag and drop the cursor. The 2D Bar Code Value dialog box will appear. Enter the Data to Encode, and click Ok or Cancel to complete operation.
Menu Commands

♦ Overlay Varnish

Overlay Varnish command opens Overlay Properties Dialog Box where you are able to choose Overlay type with preview mode; define placement and browse a File for Bitmap Based Overlay. See Section 11, Overlay, for details.

You can also use Overlay Varnish button from Design Toolbar.

♦ Magnetic Encode

Magnetic Encode command it opens Magnetic Encode Properties Dialog Box that allows the user to insert data, encoded on a magnetic stripe, on the card. See Section 9, Magnetic Encoding, for details.

You can also use Magnetic Encode Button from Design Toolbar to open the Magnetic Encode panel and access Magnetic Encode Properties.

Magnetic Encode Button:

This Tool can only be used on cards with magnetic stripe.

Data encoded on a magnetic stripe can be read and re-written many times. All data are preceded by a START sentinel and ended by a STOP sentinel followed by an LRC (Longitudinal Redundancy Check). These characters are inserted by the printer automatically.

Note: is not possible to read in Lower Coercivity a card saved in High Coercivity or vice versa.

♦ Contact Smart Card

Contact Smart Card command allows to define Contact Smart Card Properties. See Section 10, Smart Card Encoding, for details.

You can also use Contact Smart Card from Design Toolbar Button to access Contact Smart Card Properties.

♦ Contactless Smart Card

Contactless Smart Card command enables Contactless Smart Card Setup Dialog Box, where you are able to configure card technology. See Section 10, Smart Card Encoding, for details.

You can also use Contactless Smart Card Button from Design Toolbar to access the Contactless Smart Card Setup Dialog Box.
♦ **Image**

Image command displays the Open dialog box that lets you search for an image on your computer. Select an image and click Open button.

To add an image you can also use one of the following methods:

- Use Shift + I shortcut, then mouse left-click and drag cursor to other place. It will open the Imager dialog box; click File button and choose an image from your computer; click Open button; edit your image at Imager and to complete operation click Ok.
- Click the Image button from Drawing Toolbar, then mouse left-click and drag cursor to other place. It will open the Imager dialog box; click File button and select an image from your computer; click Open button; edit your image at Imager and to complete operation click Ok.

♦ **Scan - Imager Scan**

Scan - Imager Scan command allows you to capture images from a scan device.

♦ **Video - Imager Live**

Video - Imager Live command allows you to capture images from camera device.

You can also use Camera Button from Drawing Toolbar to capture images from camera device. Click Camera Button, mouse left-click and drag and drop the cursor to open Camera Dialog Box.

♦ **Biometrics**

Biometrics... command displays Biometric Enrollment Dialog Box where you are able to import fingerprints from a biometric terminal.

You can also use Biometrics Button from Drawing Toolbar to access Biometric Enrollment Dialog Box. Click the Biometrics Button, mouse left-click and drag and drop cursor.

- Terminal ID: shows terminal ID.
- Template ID: shows template ID, Enrollee Name, and displays a graphic where you are able to define which finger will you print from Biometric terminal.

♦ **Keep Placing Objects**

Keep Placing Objects command keep same tool enabled for next operations without switching to Selector tool.

You can also use Ctrl + K shortcut to use Keep Placing Objects command.
5.2.5 Options Menu

♦ Save Options

Save Options... command allows you to define autosave options.

- Select the **Enable Timed Autosave** checkbox if you want CardStudio to automatically save your work. The frequency ranges from 1 to 999 minutes.
- Select the **Autosave on close** checkbox if you want CardStudio to save your work every time you close the application.
- Select the **Enable Crash Recovery** checkbox if you want CardStudio to restore your work next time you start application. This option might slow your PC.

♦ Snap to Grid

Snap to Grid command lets you align objects to Grid. You can also activate Snap to Grid option by using the Ctrl + H shortcut.

♦ Activate Object Protection

Activate Object Protection command allows you to turn the object not selectable. The Protected option is available for all drawing objects.
♦ Activate Template Browser

Activate Template Browser allows you to turn on or off the template browser that is presented when the application is started. This can be disabled from the initial Template Browser dialog box also.

♦ Imager Settings

Imager Settings command allows you to acquire images from TWAIN interface.

VfW (Video for Windows) interface and serial port combined with a proper application.

CardStudio supports the use of any camcorder and VCR, with video output as well as digital cameras to acquire images.

Use this menu command to configure the Twain and Video for Windows Sources.

♦ Biometrics Sources

Biometrics Sources command lets you edit the various biometric configuration options: terminal type, communication settings, fingerprint display, database fields, and acquire on print options.

♦ Enable Print Log

Enable Print Log command lets you enable or disable Print Log. To activate this option simply select it from Options menu.

♦ Metrics

Metrics command lets you choose which type of metrics better fits your actual work. You can choose between Millimeter or Inch.

♦ Rulers Settings

Rulers Settings command allows you to edit Rulers Settings.

Use the Show Rulers checkbox to show or hide rulers on workspace.

Show Item Selection on Rulers check box enables a bar from each object selected that indicates the exact position of an object.
Menu Commands

♦ Grid Settings

Grid Settings command opens the Grid Settings Dialog Box where you are able to edit Grid Settings, such as Show / Hide Grid; Snap to Grid and bars spacing.

♦ Front & Back

Front & Back... command (from Options menu...) opens Card Side Switching Behavior. To use this option from menu you first need to select an object (or more); then select Front & Back... from Options menu and choose one of the following options:

- Select the Move selected objects to the other side radio button, then click the OK button. The object(s) will be moved to the other side of the card.
- Select the Don't move any objects radio button, then click the OK button. The object(s) will remain on the same side of the card.
- Select the Don't prompt again: use always this behavior checkbox to always use the selected option.

♦ Default Line Width

Default Line Width... command opens the Change Default Line Width Dialog Box where you are able to change the line width.

♦ Default Text Font

Default Text Font... command opens the Font Dialog Box where you are able to define the font that will be used by default.

♦ Monochrome Conversion

The CardStudio allows you to choose between four different algorithms to make the Monochrome Conversion: Threshold, Ordered, Floyd-Steinberg, and Burkes. Each algorithm gives slightly different results. Select an algorithm by clicking on it.

If you prefer, you can Disable the Monochrome Conversion by choosing the Disable option.

♦ Force Internal Monochrome Conversion

If this option is checked, CardStudio will convert all images from the card area to monochrome (at print time) following the algorithm selected from Options Menu > Monochrome Conversions.
♦ Reset Card Warnings

This option was created to avoid printer warnings that CardStudio is not able to control because they are issued by the Windows Driver.

♦ Reset Print Warnings

This option was created to avoid printer warnings that CardStudio is not able to control because they are issued by the Windows Driver.

♦ Bar Code 128 Control Chars

This option allows the definition of specific control characters used in Code 128 / EAN128 / UCC128 Bar Code.
5.2.6 Database Menu

See Section 13, CardStudio and Databases, for details.

♦ Connect or Disconnect

**Connect** command allows you to connect to a data source.

You can also open the Dialog Box to connect to a data source using one of the following methods:

- Use the Ctrl + Shift + C shortcut
- Use the Connect... Button on Database View.

**Disconnect** command disconnects from data source.

You can also use the Connect / Disconnect Button from Database View.

♦ First

First command shows the first record on Database. You can also use First Button from Database View.

♦ Previous

Previous command shows the previous record on Database. You can also use the Previous Button from Database View.
♦ Next

Next command shows the next record on Database. You can also use the Next Button from Database View.

♦ Last

Last command shows the last record on Database. You can also use Last Button from Database View.

♦ Refresh

Refresh command does a reload on Database.

♦ Find

Find command opens Find in Field Dialog Box that lets you search in Database using keywords filtered by item. You can also open Find in Field Dialog Box by using F3 shortcut.

♦ Add

Add command opens an empty record on Database. You can also use Add Button from Database View to add new records.

♦ Delete

Delete command deletes selected record from Database. You can also use Delete Button from Database view to delete records.

♦ Save

Save command saves current data to Database. You can also use Save Button from Database View.

♦ Report

Report command opens Database Report Dialog Box, which allows you to create, save, and print a customizable listing of your whole database or selections thereof. You can also use the Ctrl + Shift + P to open the Database Report Dialog Box.

Database Report (Dialog box); see Section 13.12, CardStudio Database Reports for details.
Menu Commands

Properties

Properties command opens the Database Properties Dialog Box that allows you to configure the Database interface properties.

You can also use the Ctrl + Shift + O shortcut to open the Database Properties Dialog Box.

Define View

Define View command allows to arrange the database view as you wish.

This command helps you if to organize the information when the table structure is different from the way you want it to be lay out.

The CardStudio allows you move, hide and un-hide fields.

You can also use the Ctrl + Shift + V shortcut to use Define View command.

Auto Print

Auto Print... command opens the Auto Print Configuration Dialog Box.
5.2.7 Window Menu

♦ Window Menu

This dropdown menu shows the open document names and lets you select which document you want to work.
5.2.8 Help Menu

Contents

Contents command shows the topics covered in the CardStudio Help file.

Using Help

Using Help command takes you to the CardStudio Help file.

Activate Product

Activate Product command allows you to enter the "License Key Number" and activate the software via the internet. Once the license key is validated, the software will restart.

About CardStudio

About. displays Product Information and the Version List for the CardStudio.
6

Working with Objects

6.1 Introduction

This section provides information on objects, their properties, and how to edit them.

CardStudio Objects ......................................................... 80
Resizing Objects .......................................................... 82
Moving and Aligning Objects ....................................... 84
Editing Text Objects ..................................................... 88
6.2 CardStudio Objects

With the exception of magnetic encoding information and Smart Card data, all cards are made up of objects. Lines, text, images, bar codes are objects.

What you can do with an object depends on whether you created it in the CardStudio or you inserted it from another application.

Once you know how to manipulate the different types of objects, you’ve mastered a lot of what’s involved in creating cards.

Terms That Apply to Objects

As you’ve already discovered, objects are the key building blocks in the CardStudio. Just about everything you work on is an object.

There are different types of objects, and the behavior of an object depends on its type. The CardStudio objects are native to the CardStudio. Embedded objects are objects you create in another application.

Some of the terms used to describe working with objects may be new to you.

- **Object**: The text, lines, and bar codes that you create using the CardStudio tools and the pictures you import from other applications.

- **Property**: Each aspect of an object that you can manipulate using the CardStudio tools and commands, including size, color, line width, and content.

- **Sizing Handle**: The square at each corner and along the sides of a selected object. Dragging a sizing handle resizes the object.

- **Bounding Box**: The box framed by the sizing handles when an object is selected. When you click an object to select it, the selection rectangle appears.

- **Picture**: An image from another application. It can have some, but not all, of the attributes of an object created in the CardStudio. You can move and resize a picture and change its rotation.

- **Stacking**: Placing objects on top of one another. Each object is separate from any other object as well as from the card background. Although the objects seem to be drawn on a flat card, it’s helpful to think of objects as pieces of paper in a stack. The object you draw first is on the bottom of the stack; the most recently drawn object is added to the top of the stack. The “stacking order” is important because the object on the top of the stack can cover those underneath it. You can see this effect when you stack one filled rectangle on top of another.
♦ Selecting and Deselecting Objects

You need to tell to the CardStudio which object you want to work with; to do this, you must select it.

To select one object

1. Touch a visible part of the object with the mouse pointer, and then click. You select an object in a stack in the same way.

2. Once the object is selected, you are free to rotate it, change its size, change its color, or move it to another location.

Tip: An object will be selected automatically if you right-click the object to edit its properties.

To select multiple objects

1. Hold down the SHIFT key, and click each object you want to select.

- or -

2. Move the pointer outside of the objects you want to select. Press and hold the left mouse button and drag in any direction. As you drag, a rectangle forms, with one corner fixed where you began to drag, the other corner following the pointer. Continue dragging until the rectangle encloses all the objects you want to select. Release the mouse button. The objects enclosed by the rectangle are selected.

To select all objects

From the Edit menu, choose Select All, or press CTRL+A.

To deselect objects

Click anywhere outside the object(s).
6.3 Resizing Objects

You can change the size of an object by dragging one of the sizing handles that surround a selected object.

Tip: If you want to resize an object (except a PDF Symbol) by an exact amount or to a specific size, use the Position Dashboard; and change the object size.

♦ Resizing an object

1. Select the object.

2. Move the mouse pointer over a sizing handle. The pointer changes appearance to indicate the direction in which you can resize the object.

3. Click and drag a sizing handle until the outline of the object is the right shape and size. To maintain the object's proportions, hold the Shift key down while you adjust the size.

♦ Resizing a Line

1. Select the Line. Sizing handles appear on each end of the line.

2. Drag one of the sizing handles to make the Line the length you want.

♦ Resizing a Rectangle

1. Select the Rectangle. Sizing handles appear on each end of the object.

2. Drag one of the sizing handles to make the Rectangle the size you want. To maintain the object's proportions, hold the Shift key down while you adjust the size.

♦ Resizing an Ellipse

1. Select the Ellipse. Sizing handles appear on each end of the object.

2. Drag one of the sizing handles to make the Ellipse the size you want. To maintain the object's proportions, hold the Shift key down while you adjust the size.

♦ Resizing a Text

1. Select the Text object.

2. Open Text Dashboard.

3. Select the desired size from drop-down menu.
Resizing a Bar Code

Important: Resizing a Bar Code requires special consideration to maintain the correct aspect ratio and data density for the Bar Code type being printed.

1. Select the Bar Code object. Sizing handles appear on each end of the object.
2. Drag one of the sizing handles to make the Bar Code the size you want. To maintain the object's proportions, hold the Shift key down while you adjust the size.

Resizing a Bar Code 2D

Important: Resizing a 2D Bar Code requires special consideration to maintain the correct aspect ratio and data density for the Bar Code type being printed.

1. Select the Bar Code object.
2. Open the Bar Code Dashboard, and edit its number of rows and columns.

Resizing an Image

1. Select the Image. Sizing handles appear on each end of the object.
2. Drag one of the sizing handles to make the Image the size you want. To maintain the object's proportions, hold the Shift key down while you adjust the size.
   or
1. Open Position Dashboard.
2. Edit image size. To maintain the object's proportions, hold the Shift key down while you adjust the size.
6.4 Moving and Aligning Objects

Naturally, you’ll want to move objects on your cards as you create them. And sometimes you’ll need to line up objects in a particular way - along the bottom of the card, perhaps, or with each other.

♦ Moving Objects

1. Select the object.

2. Drag the object to its new location. When you move an object, a dotted outline appears as you drag.

Tip: You can place an object more precisely if it is not trying to snap to the grid. Disable the Snap to Grid checkbox in the Grid Settings dialog box from the Options menu.

♦ Snap to Grid

1. From the Options menu, select Grid Settings. The Grid Settings dialog box will appear.
   a. Select the Show Grid checkbox.
   b. Select the Snap to Grid checkbox.
   c. Specify the Spacing (Horizontal and Vertical) to provide adequate grid spacing.
   d. Click on the Color button to select the desired color.
   e. When done, click on the OK button.

2. Select and move the objects to be aligned. The upper left corner of the object will snap to the grid, providing a reference location for alignment.

You can also use the Position Dashboard with Align Buttons.
♦ Aligning Objects

Use the Alignment option to align *multiple* selections of objects on the card. The selected objects will be align with the dominant object. The dominant object is the last object to be selected. The available alignments are:

- **Top Left** - Aligns the selection to the top left.
- **Top** - Aligns the selection to the top.
- **Top Right** - Aligns the selection to the top right.
- **Left** - Aligns the selection to the left.
- **Center Vertically** - Centers the selection vertically.
- **Center** - Centers the selection vertically and horizontally.
- **Center Horizontally** - Centers the selection horizontally.
- **Right** - Aligns the selection to the right.
- **Bottom Left** - Aligns the selection to the bottom left.
- **Bottom** - Aligns the selection to the bottom center.
- **Bottom Right** - Aligns the selection to the bottom right.
Distribute Objects

Use the Distribution option to distribute three or more objects on the card. To distribute objects, first select them; and then use the Distribution command or Distribution button from Drawing Toolbar.

- **Top** - Distributes objects to top.
- **Left** - Distributes objects to left.
- **Center Horizontal** - Distributes objects center horizontal.
- **Center Vertical** - Distributes objects center vertical.
- **Right** - Distributes objects to right.
- **Horizontal Spacing** - Distributes objects horizontal spacing.
- **Bottom** - Distributes objects to bottom.
- **Vertical Spacing** - Distributes objects vertical spacing.
♦ Rotating Objects

You can rotate bar codes, PDF symbols, images and single lines of text in 90 degrees increments.

1. Select the object you want to rotate and open the Position Dashboard.
2. Use the Rotation buttons (0º; 90º; 180º; 270º).

Tip: To rotate the entire card 180 degrees when the card is printed, select Rotate 180 degrees in the Card Print dialog box.

♦ Stacking Objects

When you are working with objects, you will find that you sometimes stack them to get the effect you want. When you stack objects on top of each other, they overlap. Sometimes you will want to change their order; e.g., put the top object on the bottom.

The CardStudio has two commands you can use to move objects up or down in a stack — Send to Front (Ctrl + F) and Send to Back (Ctrl + B).

You can draw objects in any order and then move them up and down the stack as required.

1. Select the object you want to move up or down in the stack.
2. Select the Send to Front (Ctrl + F) command or the Send to Back (Ctrl + B) command from Edit Menu.
3. The selected object will be placed at the front or the back of the stack.

Tip: If you are working with stack of three objects and want to place the front object in the middle, select the middle object and move it to the front.

♦ Duplicating Objects

Duplicating an object creates a copy of the object that is slightly offset from the original object. Note that the Duplicate command does not place a copy of the object in the Clipboard.

1. Select the object.
2. From the Edit menu, choose Duplicate or press CTRL+D. The duplicated item appears on top of the object you selected.
3. Drag the duplicated object to place it where you want it.

Tip: You can use the Duplicate command to make an array of objects.
6.5 Editing Text Objects

♦ Selecting and Editing Text

To select text, double-click on the text box.

Use the Text Dashboard to define text properties:

- Font, Size, Bold, Italic, and Underline.
- Color (using Black Panel will disable Color selector).
- Multiline: allows text in more than one line.
- Word Wrap: is an option when Multiline is selected and shows all text in the text box.
- Shrink to Fit: fits text in text box when Word Wrap is disabled.
- Lowercase: changes text to “aaa”.
- Uppercase: changes text to "AAA".
- Capitalized: changes text to "Aaa".

♦ Deleting Text

To delete a character, position the pointer after the character you want to delete, click and then press BACKSPACE.

To delete a block of text, drag across the text to highlight it, and then press the Backspace key or the Delete key.

To delete a text object, click on the object to select it, and then press the Delete key.

♦ Cutting, Copying, and Pasting Text

1. Drag the text to select it (highlight it); then press CTRL+X (cut) or CTRL+C (copy).

2. Position the pointer where you want to paste the text, and click to position the cursor.

7

Working with Variables

7.1 Introduction

This section explains how to use variable data with the CardStudio.

Contrary to fixed data, which is edited when the card is designed, variable data changes. It is edited or becomes available at the time the card is printed. When you design the card, instead of typing the actual data, you create a placeholder called a variable. At print time, the variable data replaces your named variable at its location on the card.

Some of the sources for variable data are: the computer keyboard, internal information that the computer system keeps track of the date and time, ODBC sources and concatenation of sources. Before variable data can be used with the tools that support it (text, bar code, PDF, image or magnetic encoding), you must create and name a variable field for each piece of information you wish to add to the card at print time. This named field then becomes the “target” for the data when you print the card.

This eliminates the need to manually edit the card to enter each piece of data before printing. You can use the same card format, knowing that your card design will remain constant, with only the variable data changing from card to card.
7.2 Variable Data

- Variable Sources:
  - Global Counter: An integer counter that starts at a number that you choose, and, each time you print a card, is increased by the value of a second number that you choose.
  - Printer Counter: An integer counter that starts at 1 and is increased by 1 each time you print a card.
  - Keyboard Input: Data that you type from the computer system’s keyboard.
  - Date/Time: The Date/Time kept by your computer system.
  - Concatenation: Data that result from the concatenation of two or more sources. In the Prefix, Separator and Suffix boxes you can edit constant data. To achieve multi-line concatenation press Ctrl + Enter in the Separator box.

- Image Sources:
  - File Choose Image: At print time, the CardStudio will prompt you to select the name of an image file.
  - Scan Image: An image acquired from any twain-compliant source at print time.
  - Video: An image acquired using the Video for windows (VFW) interface.
  - ODBC Data from internal or external database that you can access using ODBC.
8

About Bar Codes

8.1 Introduction

A bar code is a machine-readable symbol representing human readable information. The information represented can be alpha or numeric only, limited alphanumeric, or the full character set.

The human readable alpha or numeric characters are represented in the bar code symbol by a series of varying width vertical lines (called bars) and spaces. Bars and spaces together are elements. An element can be a wide black bar or white space, or a narrow black bar or white space. Each element is assigned a binary value of either “1” or “0”. To represent the necessary character in the bar code, the elements follow a precise sequential order as part of a group.

Scanning is the process of acquiring or “reading” the information encoded in a bar code symbol. To read the information contained in a bar code symbol, a scanning device such as a light pen is moved across the symbol from one side to the other. As the scanning device is moved across the symbol, the width pattern of the bars and spaces is translated back into the original information. Bar code is an optical technique because information is scanned using light that reflects off dark or light regions of the symbol.

For barcode details, see Appendix E.
8.2 1-Dimensional Bar Codes

8.2.1 Standards

The number of elements and their order is defined by the bar code standard used.

There are many bar code standards to choose from and each standard was developed for the specific data requirements of various industries. Each standard dictates the maximum number of characters a symbol can represent, as well as the kind of data represented. Consequently, the number of characters in the information field and the type of information represented will play a role in which bar code standard can be used.

Other considerations include what standard(s) trading partners use, the scanning environment (type of scanner, printable area, symbol durability, etc.) and the symbol printing requirements.

8.2.2 Symbologies

Symbology is the term used to describe the rules specifying the way data is encoded into the elements (bar and space widths) that comprise a bar code standard. Various characteristics further describe the symbology. Some of these characteristics are described below.

♦ The **Character Set** is the range of data characters that can be encoded into a given symbology. Numeric symbologies only encode numbers; others can encode numbers and letters and are called alphanumeric.

♦ The **Symbology Type** can be either discrete or continuous. In a discrete type, each character stands alone and can be decoded separately from adjacent characters. A continuous type has no inter-character gaps; the end of one character is the start of the next. This results in a higher density symbology than the discrete type, allowing more information to be encoded in less space, resulting in a smaller bar code symbol.

♦ The **Number of Element Widths** is either two (wide and narrow) or multiple. Multiple element width symbology is usually the higher density continuous type.

♦ The symbology **Length** can be fixed or variable.

♦ **Density** describes the amount of data that can be encoded in a given unit of length.

♦ A symbology is said to be **Self Checking** if a single printing defect will not cause a character to be transposed into another character in the same symbology.

♦ A **Start Code** is a particular pattern of lines and spaces indicating the beginning of the bar code symbol. A **Stop Code** indicates the end of the symbol. The start and stop codes are sometimes also used to indicate the scanning direction. In the most common symbology, Code 39, the start and stop codes are asterisks.

♦ The **Check Character** is used by the scanner to validate that the correct data has been decoded. It is placed in a predetermined position and its value is based on a mathematical relationship of the other characters in the symbol. A Check Digit is a check character that can assume only numeric values.

♦ A **Bi-directional** symbology can be successfully scanned in either direction. Almost all symbolologies in use today are bi-directional.
8.3 2-Dimensional Bar Codes

The typical bar codes we have been discussing in Section 8.1, are one-dimensional. Since they have height and width, you may wonder why they are called one dimensional. It’s because when they are read, it is only the width of the bars and spaces that is taken into account. The height of the bars is only to give the symbol some built-in redundancy. Typical bar code symbols, therefore, are only read in one dimension. Another important aspect of one dimensional bar code symbols is that they seldom represent more than a dozen characters. Therefore, the bar code usually does not contain any data; rather, the bar code most often represents the key to a record in a database, where the related information is stored.

Two-dimensional (2D) bar code symbols surpass these two preclusions. Data is encoded in both the height and width of the symbol, and the amount of data that can be contained in a single symbol is significantly greater than that stored in a one-dimensional symbol. In fact, over a thousand alphanumeric characters can be placed in a single symbol the size of a large postage stamp! Obviously, the main advantage of using 2D bar codes is that potentially a large amount of easily and accurately read data can accompany the item to which it is attached. There are new applications being created for 2D bar code technology every day.

The reading (scanning) of 2D codes is accomplished using different scanners than those made to scan 1D symbols. Two strategies are currently used. The first and most common, uses a moving laser beam scanner that not only sweeps back and forth across the symbol, but also up and down in what is termed a “raster” pattern. Alternately, CCD (charge-coupled device) scanners are used. CCD scanners use a two dimensional array of photo-sensors to scan the image in its entirety.

One of the beneficial aspects of two-dimensional symbols is their potential durability. To sabotage the readability of a 1D symbol, one only has to add another bar to the beginning or end of the symbol or draw a line through the symbol, parallel to the stripes. This throws off the checks and balances, built into the decoding algorithms of a 1D decoder and makes the symbol unreadable. By comparison, many degrees of redundancy can be built into a 2D symbol. While it makes the symbol somewhat larger, the remaining symbol is remarkably secure.
9

Magnetic Encoding

9.1 Introduction

If your printer is equipped with a magnetic stripe encoder, you can encode data onto cards that have an embedded magnetic stripe.
9.2 About Magnetic Stripe

Caution • High and low coercivity cards are not interchangeable. Refer to the printer manual to ensure that you have the correct type of card for your model printer.

There are two kinds of magnetic stripe cards: low coercivity and high coercivity. (Coercivity is the measurement of a magnetic material’s resistance to being magnetized. Low coercivity material magnetizes easier than high coercivity material.) A magnetic stripe encoder is designed to be used with one type of cards only, either high or low coercivity.

There are three magnetic tracks on a magnetic stripe card. To comply with international standards, each track is limited to a certain number and type of character.

In addition to the user data, three format characters are added automatically by the printer. The data on each track is preceded by a Start Sentinel, then followed by a Stop Sentinel and Longitudinal Redundancy Check (LRC) character.

Important • Important: Although the printer automatically inserts these three format characters at print time, you must include them in your character count to stay within the allowable character limit for each track.

The following table lists the number and type of characters allowed on each of the three tracks:

<table>
<thead>
<tr>
<th>TRACK</th>
<th>CHARACTER LIMIT</th>
<th>ALLOWED CHARACTERS</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>79 alphanumeric</td>
<td>ASCII codes 32-95 Field Separator is ^</td>
</tr>
<tr>
<td>2</td>
<td>40 numeric ASCII</td>
<td>ASCII codes 48-63 Field Separator is =</td>
</tr>
<tr>
<td>3</td>
<td>107 numeric ASCII</td>
<td>ASCII codes 48-63 Field Separator is ^</td>
</tr>
</tbody>
</table>
9.3 Encoding a Magnetic Stripe


![Magnetic Encoding Properties dialog box]

2. Select the Encode checkbox for the track (1, 2, or 3) you wish to encode.

3. If the data for the track will not be changing from card to card, type the data in the Data to Encode textbox for that track.

4. If the data for the track will be changing from card to card, in the Variable Source box, select the variable that is going to provide the data for that track.

5. Repeat steps 2, 3, and 4 for each track you wish to encode.

6. Select the appropriate Encoding Options (the default is ISO encoding).

7. When finished, click OK.


9. Select the Encode check box to enable magnetic stripe encoding.

10. Specify the Print Range. If printing more than one card, click Multiple; and enter the number of cards to print. Enter the Number of copies of each card to print.

11. Click OK, to print the card(s).

12. Every card will be magnetically encoded with the specified data. If the Print checkbox from the Operations section is enabled, printing starts after the encoding process.
10 Smart Card Encoding

10.1 Introduction

The CardStudio allows to plug-in an executable file during the printing process. The CardStudio will call an external chip card processing software.

To run this software you have to provide the necessary parameters in the Chip Card Properties dialog box.

At print time, the CardStudio will position the card on the chip interface of your printer and call the external software.

The CardStudio continues the print process either on user command or after receiving a return file OK-message.
10.2 Contact Smart Card

10.2.1 Properties

Setting the Contact Smart Card Properties:

1. From the Drawing Toolbar, click the Contact Smart Card Properties icon (arrow below).

2. The Contact Smart Card Properties dialog box appears.
3. In the **Command Line** section, type the path of the executable file of your contact smart card processing software in the Command Line box. You can also click the Browse button next to the Command Line box. The Choose Application File dialog box appears. Select the directory of your executable file, and click OK.

![Contact Smart Card Properties](image)

4. Set (optional) the arguments supported by your chip card processing software in the arguments box.

5. Select the *Don’t show error messages* checkbox if you want to skip the contact smart card error process.
6. In the **Variable Source** section, select the data source (variables) you want to provide; see [Section 7, Working with Variables](#). The data source you defined will be displayed in the **Source Data box**.

![](image)

7. In the **Continue Print Process** section, select (by selecting the appropriate radio button) how you want the print process to continue.

   - **On User Choice**, you have to click the Continue button in the Chip Card Process dialog box, after the chip card encoding process terminated.

   - **On Return File OK**, the CardStudio continues the printing process automatically, after receiving an OK message from a file created and returned by the contact smart card processing software. Type the path of your return file in the **Return File box**. You can also click the Browse button next to the Return File box. The Choose Return File dialog box appears. Select the directory of your return file, and click OK.
8. In the **Quote Character** section, check the Insert Quote Character option if you want to use a delimiter to specify the data to be encoded.

![Contact Smart Card Properties dialog box](image)

- Assuming that the encoding program is named SMARTPRG.EXE and the data to encode that comes from a Keyboard Input Source is Hello World, and the option Insert Quote Character is not checked. The application will be called like: SMARTPRG.EXE Hello World. The application will only encode the word Hello, because for the application:

  SMARTPRG.EXE - is the application name  
  Hello - is the first argument  
  World - is the second argument

- But if you define a quote character for example `. The application will be called like: SMARTPRG.EXE “Hello World” All data will be encoded, because for the application:

  SMARTPRG.EXE - is the application name  
  Hello World - is the first argument

9. In the **If an error occurs** section, you can specify, by selecting the appropriate checkbox, what to do if an error occurs; i.e., Abort, Ignore, or Retry.

10. Click the OK button to confirm all settings.
10.2.2 Contact Smart Card Encoding

Printing the Contact Smart Card:

1. From the File menu, choose Card Print. The Card Print/Process dialog box appears.

2. To select a printer, click on the red down-pointing arrow (circled below). Observe the Printer Selection popup.

3. Select the printer.

4. In the Operations section, select the Contact Smart Card checkbox (right arrow above). If you also want to print the card, select the Print checkbox (left arrow above).

5. Click OK.
10.3 Contactless Smart Card

10.3.1 Setup

1. From the Drawing Toolbar, click the Contact Smart Card Properties icon (arrow below).

2. The Contactless Smart Card Setup dialog box appears.

3. Select the Encoder from the dropdown menu, and make appropriate settings.

4. Click the Apply button to confirm all settings.
10.3.2 **Contactless Smart Card Encoding**

Printing the Contactless Smart Card:

1. From the File menu, choose Card Print. The Card Print/Process dialog box appears.

2. To select a printer, click on the red down-pointing arrow (circled below). Observe the Printer Selection popup.

3. Select the printer.

4. In the Operations section, select the Contactless Smart Card checkbox (right arrow above). If you also want to print the card, select the Print checkbox (left arrow above).

5. Click OK.
11.1 Introduction

An overlay (or varnish layer) is a thin transparent coating applied to a card to protect the underlying printed information from wear. You can include a bitmap pattern in the overlay as a security measure, creating a hologram effect.
11.2 Defining an Overlay

♦ To define an overlay

1. From the Draw menu or Drawing Toolbar, choose Overlay Varnish.

2. The Overlay Properties dialog box appears.

3. As you define the overlay, the Overlay Preview section will show the area of the card where the overlay will be applied.
4. In the Choose Overlay dropdown menu, select the desired overlay type:
   - **Full Coverage** (the default): The overlay varnish is applied over the entire surface of the card.
   - **No Overlay**: No overlay varnish is applied to the card.
   - **User Selected Area, Covered**: The overlay varnish is applied only to the area you define.
   - **User Selected Area, Not Covered**: The overlay varnish is applied to the entire surface of the card except to the area you define.
   - **Bitmap Based Coverage**: In the Choose bitmap for Overlay list box you select or browse a bitmap file on disk to use as the overlay.
   - **Predefined Selected Area Without Overlay**: This overlay varnish is automatically selected if you choose one of the following predefined area selections: Smart Card ISO, Smart Card AFNOR, and Magnetic Stripe.
   - **AutoLocation Overlay**: The overlay varnish is applied only over the object’s design on the card.

5. Define the position and size of the overlay or the excluded area.
   a. Enter the **Horizontal Position** and **Vertical Position** values in inches. These numbers indicate the upper left corner of the overlay area. The origin (0, 0 point) is the upper left corner of the card. The Horizontal and Vertical Position values are measured from the origin.
   b. Enter the **Horizontal Size** and **Vertical Size** values in inches. These numbers indicate the size of the overlay or the excluded area.

6. If you wish to see the overlay area depicted on the card, select the **Preview on Screen** checkbox. The bitmap-based overlay has no preview.

7. Click OK. You have defined the overlay.

**Important**: Because the overlay is used to protect the printed information, the overlay should not be applied to card areas containing the magnetic stripe, smart chips, or barcodes. Parts of Card Objects, which reach into User Selected Area Without Overlay or Predefined Selected Area Without Overlay, are not printed. Areas without overlay appear white.

**Printing Overlay with Memory Extension**: The printable area without Memory Extension (ME) does not cover all the card surface, only with ME the printable area is extended to the edge of the card, and the whole card can be printed with overlay.

**Important**: You may not delete the overlay. If you want to print without the overlay, choose the Overlay Clipping Option from the Options Menu; and enable the option No Overlay. It is not allowed to send the object overlay to the other layer. To print both sides of the card with overlay, you need to choose the option Overlay Clipping from the Options Menu for both sides. With the feature Front and Back the overlay can be managed in both sides of the card independently.
11.3 Bitmap Based Overlay

To prepare a bitmap and define overlay properties:

1. Use a Windows application, like Paint, to draw the image.

2. Set width = 85.3mm and height = 52.8mm. Type a number in the area where you want it later to appear on your card. Use black letters.

3. Save the image as bitmap (e.g., phone.bmp).

4. From the Draw menu, select Overlay Varnish. The dialog box appears.

5. In the dialog box, select Bitmap Based Overlay.

6. Browse to, select the overlay image you created (e.g., phone.bmp), and click OK.

7. Print the card. Note that the overlay is printed in all white areas, sparing out the black number. Hold the printed card near the light; the number appears as a kind of hologram.

Note: you may only use one kind of overlay type for the same card side.
12 Logins and Passwords

12.1 Introduction

The CardStudio provides customizable security and access level. Whenever you start the CardStudio, the Login Dialog box appears.

![Login Dialog Box](image)

The default login is **admin**, and the default password is **admin**. Login is an access level; password is the access authorization.

Note that this option can be disabled via the **File > Logins > Login Control** and de-selecting the Enable Login Control checkbox.

**Note** • This feature is only available in the **Professional** version of CardStudio.
Logins and Passwords

12.2 Logins and Passwords

12.2.1 Administrator Login

1. From the File menu, select Logins. The Login Control dialog box appears.

2. Select the Enable Login Control checkbox (arrow above) to activate this security feature.

3. Select Administrator, and click the Edit button. The User Login Properties dialog box appears.

4. Type a login of your choice. Proceed with your password, and confirm it. The database login and password give access authorization to an external database of yours. Make sure all Permissions are selected.

5. When complete, click on the OK button.
12.2.2 Create User Login

1. From the File menu, select Logins. The Login Control dialog box appears.

![Login Control dialog box]

2. Click the New button. The User Login Properties dialog box appears.

![User Login Properties dialog box]

3. Enter the Login Information: Name, Login, Password, and Confirm Password.

4. If applicable, enter the Database Connection Credentials: Login and Password.

5. Depending on what kind of job you want your employee to perform, select one or more Permissions checkboxes; see Permissions on the next page for details.

6. When complete, click on the OK button.
12.2.3 Permissions

The Permissions section controls access to content creation, modification, and card administration at the application level.

The Administrator assigns permissions to roles, then assigns roles to users via the User Login Properties dialog box.

Permissions include:

- **Login Control**: allows editing logins and passwords.
- **Edit Cards**: allows editing cards, including magnetic encoding and chip card setting.
- **Print Cards**: allows printing cards.
- **Edit Configurations**: allows operating print functions and configurations.
- **Edit Database**: allows editing databases (after CardStudio restart).

In the example above, Richard can select and edit database records and print individual cards.
## Permissions Table

<table>
<thead>
<tr>
<th>Permissions</th>
<th>If not checked</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login Control</td>
<td>Selected user cannot access to User Login Properties (File menu</td>
</tr>
<tr>
<td>Edit Cards</td>
<td>Fully protects card objects</td>
</tr>
<tr>
<td></td>
<td>Disables Design and Encode buttons</td>
</tr>
<tr>
<td></td>
<td>Disables all Dashboard sliders/options except Database</td>
</tr>
<tr>
<td></td>
<td>Disables New and Remove buttons on Card Designs</td>
</tr>
<tr>
<td></td>
<td>On Draw Menu disables all options</td>
</tr>
<tr>
<td></td>
<td>On Options Menu disable:</td>
</tr>
<tr>
<td></td>
<td>• Autosave options</td>
</tr>
<tr>
<td></td>
<td>• Snap to grid</td>
</tr>
<tr>
<td></td>
<td>• Activate object protection</td>
</tr>
<tr>
<td></td>
<td>• Biometric sources</td>
</tr>
<tr>
<td></td>
<td>• Ruler settings</td>
</tr>
<tr>
<td></td>
<td>• Grid settings</td>
</tr>
<tr>
<td></td>
<td>• Default line width</td>
</tr>
<tr>
<td></td>
<td>• Default text font</td>
</tr>
<tr>
<td></td>
<td>On Edit Menu disables all options except Predefined Names List Editor</td>
</tr>
<tr>
<td></td>
<td>On File Menu disable:</td>
</tr>
<tr>
<td></td>
<td>• New</td>
</tr>
<tr>
<td></td>
<td>• Save</td>
</tr>
<tr>
<td></td>
<td>• Save as</td>
</tr>
<tr>
<td></td>
<td>• Card Setup</td>
</tr>
<tr>
<td>Print Cards</td>
<td>Disables print button on Card and Database Layout</td>
</tr>
<tr>
<td></td>
<td>Disables print option on End Of Fields</td>
</tr>
<tr>
<td></td>
<td>On File Menu disable:</td>
</tr>
<tr>
<td></td>
<td>• Card Print</td>
</tr>
<tr>
<td></td>
<td>• Batch Print File Management</td>
</tr>
<tr>
<td></td>
<td>On Database Menu disables Auto Print</td>
</tr>
<tr>
<td></td>
<td>On Options Menu disables Enable Print Log</td>
</tr>
<tr>
<td></td>
<td>On Database Properties Dialog disables Print Record option on End of Fields section</td>
</tr>
<tr>
<td>Edit Configurations</td>
<td>Disables Printer Properties on Print Dialog</td>
</tr>
<tr>
<td></td>
<td>Disables Card Setup Dialog on File Menu</td>
</tr>
<tr>
<td></td>
<td>Disables Database Properties on Database Menu</td>
</tr>
<tr>
<td></td>
<td>Disables Database Properties Button on Database View</td>
</tr>
<tr>
<td>Edit Databases</td>
<td>Disables fields on Design View Dashboard Database Slider</td>
</tr>
<tr>
<td></td>
<td>Disables fields on DB View Record Area</td>
</tr>
<tr>
<td></td>
<td>Disables Add, Save, and Delete Buttons on DB View toolbar</td>
</tr>
<tr>
<td></td>
<td>Disables Add, Save, and Delete options on Database Menu</td>
</tr>
</tbody>
</table>
13.1 Introduction

This section explains how to work with the CardStudio and databases. Learn how to create your own database from within the CardStudio and how to connect to an external database using ODBC drivers.

- Introduction to ODBC .......................................................... 118
- Database Structure ............................................................... 120
- Data Type ........................................................................ 121
- Data Source ...................................................................... 122
- CardStudio Internal Database ............................................. 123
- CardStudio Internal Text Data Source ................................. 127
- Connect to an External Database .............................. 129
- Working with the Database Interface .............................. 130
- Database Toolbar (Database View) ................................... 132
- CardStudio Database Functions ...................................... 133
- CardStudio Database Reports .......................................... 134
- Auto Print Function ............................................................ 135
13.2 Introduction to ODBC

♦ ODBC Basics

The Open Database Connectivity (ODBC) interface allows accessing data in Database.

Management Systems (DBMS) using Structured Query Language (SQL) as a standard for accessing data.

The CardStudio accesses databases via ODBC drivers, using SQL language.

ODBC allows different database technologies to be used by defining a standard interface.

♦ File Formats

To access any database format from the CardStudio you will need the ODBC driver for that standard. The default drivers, which come with the CardStudio CD-ROM supply the most common formats:

- Microsoft Access Driver (*.MDB)
- Microsoft dBase Driver (*.DBF)
- Microsoft Excel Driver (*.XLS)
- Microsoft FoxPro Driver (*.DBF)
- Microsoft Paradox Driver (*.DB)
- Microsoft Text Files Driver (*.TXT ; *.CSV)
- Microsoft Visual FoxPro Driver
- SQL Server

Note • You can add anytime your specific drivers to meet your needs. Just as an example, you can add drivers to access AS400 files directly from the CardStudio.

♦ Purpose of ODBC

ODBC was created as a way of setting a standard to access data on files.

Using concepts like layers and layer abstraction, it allows the user to access data on his hard disk, in a local network, or even in a Wide Area Network (WAN) using desktop or server/client specifications, in any database format that has an available ODBC driver.
♦ Desktop versus Server/Client

Desktop file access means, that the file is accessed opening it as a disk file, in the local hard disk or even in a local network. Server/Client supposes that somewhere a DBMS server is running.

The local machine sends requests to the server resulting in data available to the client. The CardStudio does the access to both types in an easy and similar way. One difference will be that in a DBMS Server the user will need to “login” the database.

♦ SQL

SQL is the standard that the CardStudio uses to “talk” to ODBC, issuing commands to read and write data on the files.

♦ CardStudio Sources

CardStudio classifies data in two classes:

• Internal Data Sources, which it assures to exist and automatically configures.

• External Data Sources, which must be configured by the user running the ODBC administrator to gain access to his files.

Basically both data types use the same methods. Internal Data Sources make life easier for a user, who does not have a database system already installed.
13.3 **Database Structure**

Database, Table, Record, Field, Data: Those five terms build the structure of a database. It is easy to understand which meaning each term has, if you imagine an office closet.

- **Database**: the office closet itself
- **Table**: a card-index box inside the closet
- **Record**: a file-card inside the card-index box
- **Field (Column)**: a predefined part of the file-card, for example name field or address field, etc.
- **Data**: the particulars typed in the name field.
13.4 Data Type

♦ About Data Types

Database columns are defined to contain a certain type of data, the most commonly used data type is CHAR (stands for character). You need to define different data types for each column, if you want to store data like images directly in a column.

Each database format supports different data types, which are translated by the ODBC driver into an SQL data type. This allows an application to interact with a database bidirectionally.

This interaction is not 100%, though, as each different driver imposes certain limitations.

♦ CardStudio Internal Database Data Type

The CardStudio supports five Data types: Text, Number, Integer Number, Photo, and Memo.

- **Text**: The data type text builds a single-line field, which may contain up to 254 characters.

- **Number**: The data type number builds a single-line field, which may contain any value between 1.7e-308 to 1.7e+308

- **Integer Number**: The data type integer number builds a single-line field, which may contain any value between -2,147,483,648 and 2,147,483,647

- **Photo**: The data type Photo builds a field, which allows the storage of an image.

- **Memo**: The data type Memo builds a multi-line field for text editing.
13.5 Data Source

Before you can access data with an ODBC driver, you must add a data source for it.

You can change or delete a data source at any time. A data source contains the information which ODBC driver is to be used, including driver specific setup and the indication where to find the database itself.

See section External Database later in this chapter to learn, how to work with data sources.
13.6 CardStudio Internal Database

13.6.1 Create a New Internal Database

1. From the Database menu, click Connect. The Select Source dialog box appears.

2. Select Card Software Data Source, and click Next.

3. The Select Database dialog box appears.
4. Click on the Create Database button.

5. The Create Database dialog box appears.

6. Type the database name, for example COMPANY and click OK.

7. In the Select Database dialog box, select the Database you just created; and click Next.

8. The list of the available tables appears and prompts you to select the table you want to work with.

9. As there is no table available yet, create it by clicking New Table.
10. The Database Table Structure dialog box appears.

11. Type the table name (e.g., Clients); You may not use the space character to separate words, as it provokes a syntax error in the create table statement.

12. Define the columns. For each column, you want to create provide column name (e.g., Name, Idnumber, and Photo) or use the default name (Field1, Field2, Field3).

13. Select column data type and length (if necessary).

14. Provide the type of Index you want to apply to the column. An index is used to control data storage and queries in a column. Choose between None (in this case, no indexing occurs), Unique (indexed, each record must contain unique data, used to set a primary key) or Duplicate (indexed, but allows equal data, speeds up queries).

Note: The field RECORD_NR is automatically created and indexed as unique to provide at least one column, where data differs in all records (primary key). This is to avoid affection on multiple records at delete or edit operations. You may delete this column, but you should provide at least one column indexed as unique.

15. To remove a column from your table, select the column name; and click on the Remove button.

16. Create your table by clicking Finish. The Select Table dialog box appears. Your table named Clients is highlighted. Choose it by clicking Finish.

17. The database view appears in a split-window next to the card view. Use the database toolbar to navigate, add new, modify, or delete records.
13.6.2 Working with an Internal Database

♦ Open an Internal Database

1. From the Database menu choose Connect. The ODBC Source Selection dialog box appears. Select the database filename you want, and click Next.

2. Select the operation you want to perform, and proceed as required.

♦ Disconnect from a Database

From the Database menu, choose Disconnect.

♦ Edit an existing Table

1. After connecting to an internal database, the Select Table dialog box appears.

2. Select the table you want to edit; and click Modify.

3. The Database Table Structure dialog box appears.

4. Add and Remove Columns as required.

5. When done, click Finish.

♦ Remove a Table

1. After connecting to an internal database the Select Table dialog box appears.

2. Select the table you want to remove, and click Remove.

3. The CardStudio prompts you with a warning message. If you really want to remove permanently the table you selected, confirm by clicking Yes.
13.7 CardStudio Internal Text Data Source

CardStudio allows you to connect directly to a text file (*.asc, *.csv, *tab or *.txt), which are ASCII text files with data sets in individual lines and fields separated by comma, tab or custom delimiter. This type of file are read only, you cannot use CardStudio to edit data.

Connecting to a Internal Text data source

1. From the Database menu, choose Connect.
2. The Select Database Source dialog box appears.
4. Click Next to continue.
5. The Select Text Data Source dialog box appears.
6. Select the file you want to work with. If you don’t see the file you want, use the Browse button to locate the file.
7. Click Next to continue.
8. The Define Internal File Format dialog box appears.

9. Make sure all the settings are correct.
   - **Selected File** - Specifies the selected text file.
   - **Has Column Header** checkbox - Specifies whether the columns of the selected table first row will be used as column names.
   - **Format** - Lists all the available formats:
     - Comma Separated Values
     - Tab Separated Values
     - “Pipe” Separated Values
     - Custom Defined (If Custom Defined is selected, specify the type of delimiter used.)
   - **Delimiter** - The custom delimiter character to be used to separate columns. Must be only one character in length, and double quotation marks (") cannot be used. This option is enabled when Custom Defined is selected from the Format list box.
   - **Columns** - Lists the column names for each column in the table selected in the Selected File and reflects the order of the columns in the table.
   - **Name** - Displays the name of the selected column. Can be used to specify a new column name for an existing column.
   - **Data Type** - Displays the data type.
   - **Width** - The width of the column.

10. Click Finish to open the table.
13.8 Connect to an External Database

ODBC Source Selection

Before you can connect to a database you must define a data source first (as explained earlier in this chapter in section “Data Source”).

When you connect to a database for the first time, you will find default data sources listed in the Data Source Selection dialog box. These sources are set for each of the installed drivers, defining the default driver settings and the default database directory, which is c:\windows\system\.

To connect to your database, you have to setup a new data source for it first (or edit an existing source). The next sections explains, driver specific, the ODBC data source setup.
13.9 Working with the Database Interface

After connecting successfully to a database, the selected table is displayed in a split window next to the card design area. To access the record information of a column, you have to create CardStudio objects; and connect them with the database fields.

How to link database fields with the card layout:

♦ Linking a Text Object

Note: you can easily create a Text Object linked to the database by dragging and dropping the field name from the database area into the card work area.

1. Open a text object, and select ODBC Source as Variable Source.
2. The Source ODBC Source Selection dialog box appears.
3. Select the column which contains the records you want to appear in your text object, and click Finish.
4. Edit the font properties you want, and confirm by clicking OK.
5. In the card work area, resize (if necessary) the selection rectangle of the text box in a way that makes the largest record of your column fit inside.
6. Save your card layout. Your card and database are connected. Whenever you open your card, the database will be found automatically and opened.

♦ Linking an Image Object

There are two forms image information is stored in a database. Either the image is part of the database itself, stored in an image field (ODBC, point to image field), or the path directory of the image field is stored in a text field; e.g., c:\images\001.bmp (ODBC, point to image file). The CardStudio supports multiple image field and/or image file linking.

Note: you can easily create an Image Object linked to the database by dragging and dropping the field name from the database area into the card work area.

1. Open an image object and choose either ODBC, point to image field or ODBC, point to image file.
2. Select the column which contains the information of your image, and click Finish.
3. Confirm the Source Image Properties by clicking OK.
4. In the image Object dialog box, choose the options (rotation, keep aspect, protected) you want to apply; and click OK.
5. In the card work area, resize the image. You can resize the image with the mouse.
6. Save your card layout. Your card and database are connected. Whenever you open your card, the database will be found automatically and opened.
Linking a Bar Code Object
1. Open a bar code object and select ODBC Source as Variable Source.
2. The Source ODBC Source Selection dialog box appears.
3. Select the column which contains the records you want to appear in your bar code object, and click Finish.
4. Set the Bar Code Object Properties you want to apply, and confirm by clicking OK.
5. In the card work area, you can resize (if necessary) the bar code with the mouse.
6. Save your card layout. Your card and database are connected. Whenever you open your card, the database will be found automatically and opened.

Linking a PDF Symbol Object
1. Open a PDF symbol object and select ODBC Source as Variable Source.
2. The Source ODBC Source Selection dialog box appears.
3. Select the column which contains the records you want to appear in your PDF symbol object, and click Finish.
4. Set the PDF symbol Object Properties you want to apply, and click OK.
5. Save your card layout. Your card and database are connected. Whenever you open your card, the database will be found automatically and opened.

Linking a Magnetic Code Object
1. Open a Magnetic Code object and select for the track(s) (1 to 3) you want to encode ODBC Source as Variable Source.
2. The Source ODBC Source Selection dialog box appears.
3. Select the column which contains the records you want to encode in each track, and click Finish.
4. Save your card layout. Your card and database are connected. Whenever you open your card, the database will be found automatically and opened.
13.10  **Database Toolbar (Database View)**

Design buttons are located across the top of the CardStudio window.

**Database Toolbar**

- **View**: change from Database View into Card Design View.
- **DB Open / Close**: connect / disconnect from the Database. Note that the icon turns red when disconnected from the Database.
- **Database Properties**: edit Database properties.
- **Define View**: arrange the Database view as you wish; i.e., change the order of the fields.
- **Back**: go to the first record on Database.
- **Back**: go to the previous record on Database.
- **Add**: add record to Database.
- **Save**: save record / data on Database.
- **End of Fields**: if selected in Database properties, allows to execute the "end of fields" operations at any moment.
- **Remove**: remove record from Database.
- **Forward**: go to the next record on Database.
- **Forward**: go to the last record on Database.
- **Print**: print the current card.
13.11 CardStudio Database Functions

♦ Editing a Database

- To add a new record to your database, select Add from the database menu. You can also click the Add Record button on your database toolbar.
- To save a new or edited record, select Save from the database menu. You also can also click the Save Record button on your database toolbar.
- To delete a record, select Delete from the database menu. You also can also click the Delete Record button on your database toolbar.

♦ Moving between Records

- To move to the first record, select First from the database menu. You also can click the Move First button at your database toolbar.
- To move to the last record, select Last from the database menu. You also can click the Move Last button at your database toolbar.
- To move to the next record, select Next from the database menu. You also can click the Move Next button at your database toolbar.
- To move to the previous record, select Previous from the database menu. You also can click the Move Previous button at your database toolbar.

♦ Hide/Unhide Fields

- To Hide Fields
  1. Click the Define View button from the database toolbar.
  2. Right-click on the field name you want to hide and choose Hide.

- To Unhide Fields
  1. Click the Define View button from the database toolbar.
  2. Right-click anywhere on the database area, and choose Unhide.
  3. The Unhide dialog box appears, select the field you want to unhide one by one or click Unhide All to show all the database fields in the database area.

♦ Database Image Properties

To open the database image properties dialog box right-click the database image field. Image size, resolution and compression ratio are displayed.
13.12 CardStudio Database Reports

The CardStudio Database Report is an useful tool, providing you to create, save and print a customizable listing of your whole database or selections thereof.

♦ Create Database Report

1. From the Database menu, select Report or click the Report button in the Database Toolbar. The Database Report dialog box appears.

2. Type the listing title. Select the field(s) you want in your report from the Database fields box, and click the Move Right button. You also can double-click the field to move it to the Fields to print box. To deselect a field from the Fields to print box, select it; and click the Move Left button. You also can double-click the field to move it back to the Database Field box.

3. Save your database report, clicking the Save button. The Save As dialog box appears. Type a filename, and click OK.

4. Use the CardStudio Filter Functions to make a selection of records.

5. To select the font style and size you want your report printed with, click the Font button. The Font dialog box appears. Make your choice, and click OK.

6. Optionally you can change your Printer Setup. Click the Print Setup button, and make your choices (page layout, default printer, print to file, etc.), and click OK.

7. To print your report, click the Print button in the Database Report dialog box.

Note: If you click the Close button without saving your database report, the selection you made will be permanently lost.
13.13 Auto Print Function

The Auto Print concept is a powerful additional database/print function which permits
database edition and automatic print on one or in different workstations.

Information about which cards (records) were already printed is automatically added to the
database, the CardStudio keeps track of the printing process and only newly edited cards
(records) will be printed.

13.13.1 Preparing the CardStudio for Auto Print

♦ Prepare a Database for Auto Print

Plan the layout of the database to be used for auto print, adding all fields you need to
store the information you require.

Create one extra field (field type must be numeric or char), which will store the
information if cards (records) were printed or not. This field may not be indexed
‘unique’.

Make sure you choose a database format which comes with an ODBC driver
permitting bi-directional editing (dBase, Access, etc.).

If you need to use an already existing database, add one field which will contain the
print information of the cards (records). If you define an already existing field to
contain these information, all data in this field will be erased.

The database file must be shareable between different users (may not be exclusive,
read only, etc.).

♦ Prepare Workstations

1. On the first workstation, prepare all settings to edit the database you prepared
   (see above).

2. In the second workstation, create the card layout and link it to the database.

3. Make sure the Allow data edition check box in the database interface properties
dialog box is enabled.

4. Make sure the right printer/ribbon settings are defined.

5. Save the card document.
13.13.2 Start Auto Print

1. From the database menu select Auto Print…. The Auto Print Configuration dialog box appears.

2. Define the **Print Control Field**. From the dropdown menu, select the control field you defined in Section 13.13.1.
   - If the print control field is **text** type, its data will be replaced by a “***” (or and if the field is big enough the data will be replaced by the print date and time) if the print process was performed correctly, otherwise by “E”.
   - If the print control field is **numeric** type, its data will be replaced by “1” if the print process was performed correctly, otherwise by “9”.

3. Define a **Guide Field**. Choose a field which best describes each card (record); e.g., a field which includes a name, id-number, etc. Besides the print date and time its contents is displayed in the Auto Print dialog box, helping you to control the print process.

4. Set the **Poll Delay**. This value indicates the time (in seconds) the CardStudio will wait before refreshing the database table. After refreshing the table, all cards (records), which were not printed yet are sent to the printer.

5. **Create Icon on Desktop** button and **Start when opened** checkbox. Pressing the Create Icon button will create an icon with a shortcut to the Auto Print card document at your desktop. If the start when opened check box is enabled, the Auto Print process starts performing immediately.

6. **Mark all as printed/not printed**. These buttons allow to change the information of the complete record set to printed/not printed status.
7. **OK/Cancel.** The OK button saves the Auto Print settings and closes the Auto Print Configuration dialog box. Press Cancel to leave the Auto Print dialog box without saving any changes/settings.

8. **Start Auto Print.** The final step. Click this button to perform Auto Print on workstation 2. The Auto Print dialog box appears.

9. **Stop/Close.** Stops the Auto Print function and closes the Auto Print dialog box.

10. **Save History.** Click this button if you want to save the information displayed in the Auto Print dialog box as *.txt file.
14.1 Introduction

This section explains how to setup your printer, the setup for ribbon, and the procedure to print your cards. For specific information about your printer, see the printer user manual.

Printing Process ................................................. 140
Batch Print Process .............................................. 142
Print Options ...................................................... 146
14.2 Printing Process

**Important** • Before you use a specific printer for the first time you must tell the program which printer port to use, the ribbon type and other specific options. In most cases the default configuration makes this step obsolete.

1. From the File menu, choose Card Print; the Card Print dialog box appears.

![Card Print/Process dialog box](image)

2. In the Destination section, select the card printer. Use the Properties button to change the selected printer configuration. Destination may be a specific printer or any printer through Windows driver.

3. In the Operation section, select the operation(s) to perform when printing.
   - **Print** will print a card containing all the objects you placed on the card.
   - **Magnetic Encode** will write data to the magnetic stripe on the card; refer to Section 9, Magnetic Encoding.
   - **Hologram** will print a hologram on your cards. Contact your ribbon supplier to inform you about hologram ribbons.
   - **Smart Card (Contact and Contactless)** will call an external chip card processing application; see Section 10, Smart Card Encoding.
   - **Biometrics** prints biometric data (fingerprints) on your cards.
4. In the Layout section, if you are using a printer with a card-flip assembly:
   • Check both Print Front and Print Back to print both sides of the card in one passage.
   • Select Rotate 180 Degrees if you want the card to be printed upside down, this option is available for Front and Back separately. This feature can be used if, for example, you wish to punch a hole in the card on the opposite side of the magnetic stripe, avoiding that way to damage the stripe.
   • Select the Flip on Long Edge checkbox to reverse the back side of the card, when printing both sides of the card.
   • Information about the selected ribbon(s) will be displayed.

5. In the Print Range section, select Single (1) or Multiple (2 or more) cards to print. If printing multiple, enter the number of cards to be printed.

6. In the Database section, if you using a database (Advanced Feature only):
   • Select the Print All box to print all records, or the type the Number of Records to be printed.
   • If you want to print a previously selected range of records, check the option Print Selected; see Section 13, CardStudio and Databases, section Browse View.
   • If the Keep database position checkbox is not selected, the record displayed after a database print process is the record next to the last printed.

7. Click OK.

Note: If you are printing variable data, you may be prompted to enter data from the keyboard, select an image file, or acquire an image. Otherwise, your card will be printed, while on-screen messages keep you informed of the progress.
14.3 Batch Print Process

The CardStudio allows you to create a batch file, which contains data of one or more card documents instead of printing the card documents right away.

14.3.1 Printing to a File

To create a batch print file

1. From the File menu, choose Card Print. You can also press the shortcut Ctrl+P. The Card Print dialog box appears.

2. In the Destination section, select the Send to Batch Print Manager checkbox (arrow above). All other options work the same way as printing a card document directly.

3. If you want to print multiple cards and/or multiple copies, perform magnetic encoding or chip card processing you have to set these options before you proceed with the next step.
4. Click OK. The Select Batch Print File dialog box appears.

5. Select the file you want to append, or create a new batch print file with a new name.

6. Click Open to complete the action. The Batch Print Job List and Batch Print Preview windows open.
14.3.2 Batch Print Toolbar

The Batch Print Toolbar: Tools are located along the top of the CardStudio window.

**Batch Print Toolbar**

Sets the card status to Print. Cards marked with this symbol are ready to print.

Sets the card status to Error. If an error occurs while printing, the card marked is with this symbol.

Sets the card status to Printed. Cards marked with this symbol were printed properly.

Sets the card status to Held. Cards marked with this symbol are excluded from printing.

Switches between Front and Back view.

First card.

Previous card.

Next card.

Last card.

Prints the selected status.

Close.
14.3.3 The Batch Print File Manager

To print a Batch Print File

1. From the File menu, choose Batch Print File Management. The Select Batch Print File dialog box appears.

2. Select the name of the document you want to open and click OK. The Batch Print Job List and Batch Print Preview windows appear.

   Note: The Batch Print Job List contains card documents (*.car) itself and the (multiple) cards inside each card document.

3. Browse through the Batch Print Job list using the Move buttons at your Batch Print Toolbar. You can also use the up and down arrows of your keyboard.

4. You can control the card design and its variable fields (in case your card document contains multiple cards) in the Batch Print Preview window. To toggle between both sides of the card click the Front/Back View button.

5. Select the card document you want to print. Click the Print button at your Batch Print Toolbar.

   Tip: If the selected card document contains multiple cards, you can print one specific card by selecting it instead of the card document itself.
Printing using Print Status: Over the card document, click the print button. The Status to Print dialog box appears. Select the status you want. All cards marked with the corresponding symbol will be printed. Click Continue to proceed.

Tip: You can manually change the Print Status of each card. Select the card you want to change. Click the status symbol you want at the Batch Print Toolbar. If you want to change the print status equally for all card included in the card document, select the card document and click the status button you want apply.
Print with Windows Driver

♦ Printer Types

The CardStudio allows you to print on any printer which is provided with a proper Windows driver.

- Card Printer

Using the proper Windows printer driver for your card printer, the CardStudio allows you to use any card printer. For special printer/ribbon settings, see your card printer documentation as well as related help files. Besides that, the CardStudio allows you to use any card printer it also lets you work on a card layout, database edition, etc., at print time simultaneously.

- Label Printer

The CardStudio allows you to print on any Label printer which is provided with its proper Windows driver.

Note: the label size settings must have the same measurements as the standard plastic card format: 3.375 x 2.125 inches (85.73 x 53.98 millimeters).

- Paper Printers

CardStudio permits to print on paper with any Laser, Ink Jet, or Needle printer, which comes with a proper windows driver. The CardStudio’s special column and row settings permit to print front and back side of the card on the same sheet as well as several cards on one sheet. This concept permits to print card proofs on paper or creating low cost cards using paper lamination.

1. From the File menu, choose Card Print; select the printer you want to work with; and click on the Close button.

2. From the File menu, choose Card Setup;

3. Click on the Properties button, and observe the selected printer dialog box.

4. Make the necessary driver-specific settings (paper size, orientation, etc.), and click OK.

5. The CardStudio allows you to print several cards by page (when using paper) for that select the number of rows to print (max 5).

6. Click OK.
Appendix A

CardStudio Templates

A.1 Introduction

The use of a card template on CardStudio allows you to choose images for predefined objects, like background and logos, as well as create new design objects over a template.

Data is stored on a spreadsheet with point-to-image-file fields (images are stored in a specific location), that can be linked to predefined objects on the card template.

All template-related files (data, image, etc.) are stored in default sub-folders within the CardStudio Program Folder:

C:\Program Files\Zebra Technologies\CardStudio\Templates\ < category folders >

Within the category folders are sample card folders; e.g., Adventurepass, CountryClub, Skipass, etc. Each sample card folder is structured as follows:

- ...
  - Backgrounds (Landscape or Portrait)
  - ...
  - Data (Microsoft Excel Worksheet and Photos Folder)
  - ...
  - Card Template (Adventurepass.car file)
A.2 Creating Template Designs

The Card Type templates consist of Sample Card designs created with CardStudio, and by applying the following design objects and rules:

1. The Card Type Template designs will reside under the following directory structure under C:\Program Files\Zebra Technologies\CardStudio\Templates\.....

   Existing template design categories in CardStudio include the following:
   - \Template\Clubs and Associations
   - \Template\ID Cards
   - \Template\Other Card Designs
   - \Template\Schools and Libraries
   - \Template\Visitor Badges

2. To create a new CardStudio template category, simply create a new subfolder under C:\Program Files\Zebra Technologies\CardStudio\Templates\.....

   i.e. if you create the directory C:\Program Files\Zebra Technologies\CardStudio\Templates\Companytemplates

   "Companytemplates" will now show up on the Templates browser viewer when you open up any new template designs.

3. Under each \Template\<Card Type> directory will consist of several example card template design directories.

   For example under \Template\Other Card Designs has the following sample card template designs to choose from:
   - \Template\Other Card Designs\BusinessCard
   - \Template\Other Card Designs\First Aid Card
   - \Template\Other Card Designs\LuggageTag
   - \Template\Other Card Designs\TradewshowID

   To create a new template design first create a new directory with the exact name that you would like to call your new template design.

   For example you could create a new template design called "Tradeshow09" under the "Other Card Designs" template category by first creating the following file directory name:
   - \Template\Other Card Designs\Tradeshow09
4. Each sample template card design directory has the following sub directory structure and sample card design file structure:

   ..\Backgrounds\..

   ..\Data\..

   Cardexample.CAR

Sample Card Template Design: under the Card Template category directory is the actual card template design. This card design must be named the same as the category name and will have a .CAR file name extension. This file must be created and saved as a card design in CardStudio.

   \Template\< Card Type >\Template Designs\BusinessCard\businesscard(*.CAR)

This is the sample Template Card design that shows up in the template design viewer in CardStudio.

In the "Tradeshow09" example above you would create a new Card Design in CardStudio, and save this design as:

   \Template\Other Card Designs\Tradeshow09\Tradeshow09.CAR

**Note** • CardStudio saves all Card Design files with a .CAR file name extension; i.e., Filename.CAR

For the Template design to display in the Template viewer the Card Design file name created under the template design category and the actual Card design name be EXACTLY the same:

   \Template\Other Card Designs\Tradeshow09\Tradeshow09.CAR
A.3 Template Backgrounds and Data

\Template\< Card Type >\Template Designs\BusinessCard\Backgrounds

This directory has a portrait or landscape subdirectory based on the template design and contains all the available background selections in .jpg format.

Any graphics files placed in this subdirectory will show up as background options in the template designer background viewer.

Backgrounds\ <Landscape or Portrait > \filenames.jpg  These consist of:

Backgrounds.jpg - Various backgrounds images.

Image Object "Set as BackGround"

\Template\< Card Type >\Template Designs\BusinessCard\Data

This directory has a native .XLS file that contains the datafile associated with the template design.

Data\template_datafile(*.XLS) - This directory contains the associated datafiles as Excel spreadsheets for the associated design samples under Card Types.

Database Fields - Objects of any kind, linked to the Database

Any photos linked to the .XLS data file are automatically defaulted to storage in the "Photos" subdirectory under Data.

Data\Photos\*.JPG - This directory contains all the associated pictures created as part of the example card design and datafile associated with a card design.

Person Photo - Image Object - Database Point to File
A.4 Template Design Rules

All of the template design objects will be "Locked" so the user experience will be like using a predefined application instead of design objects loose on the cards.

Opening a template:

leaves the user with an "Card1.car" - untitled - that should be given a name at save time.

will link to the spreadsheet that acts as a DB, allowing text editing of datafile¹

Company Logo.jpg - Company or sample company graphic images. Company Logo -

Image Object - Variable name: Company Logo

Company_Name.(txt) - Company Name (in stylized text) Company Name -

Text Object - Variable Name: #Company Name. (Note: the Variable name must have the "#" as a prefix to show up in the template designer.

Card_Text² (tag line).(txt) - Any misc text created and presented as part of the card design example.

Card_Text - Text Object - VN: #Tag Line (Note: the Variable name must have the "#" as a prefix to show up in the template designer.

Image File (Photo) - To associate a photo to a data record in an Excel spreadsheet

Select the image file in the card design and select Database, Point to Image file under "Source"

1. Assuming end user has Microsoft Excel to open datafile
2. Changed from Tag_Line in original proposal
Select the Data column that you would like to associate with the Image Photo.

Then select Global Unique Identifier. This will create a GID image file name and place it in the designated data file above.
Appendix B

Keyboard Shortcuts

B.1 Introduction

This section lists the keyboard shortcuts available for the CardStudio commands.
# Keyboard Shortcuts

## B.2 Shortcut Keys

Use the following key combinations to execute the command listed next to it. When the keys are connected by a +, it means to press both keys at the same time.

### Card Work Area

<table>
<thead>
<tr>
<th>Key Combination</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Ctrl+P</td>
</tr>
<tr>
<td>Ctrl+Z</td>
</tr>
<tr>
<td>Ctrl+Y</td>
</tr>
<tr>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Ctrl+D</td>
</tr>
<tr>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Ctrl+Shift+F</td>
</tr>
<tr>
<td>Ctrl+F</td>
</tr>
<tr>
<td>Ctrl+B</td>
</tr>
<tr>
<td>Ctrl+1</td>
</tr>
<tr>
<td>Ctrl+2</td>
</tr>
<tr>
<td>-</td>
</tr>
<tr>
<td>+</td>
</tr>
<tr>
<td>Ctrl+L</td>
</tr>
<tr>
<td>Ctrl+G</td>
</tr>
<tr>
<td>Ctrl+K</td>
</tr>
<tr>
<td>Ctrl+H</td>
</tr>
</tbody>
</table>
Database Window

To enable these shortcuts you must select the database view by simply clicking on one of the database fields.

<table>
<thead>
<tr>
<th>Key</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F6</td>
<td>Open from File</td>
<td>Opens an image file from disk.</td>
</tr>
<tr>
<td>F5</td>
<td>Paste</td>
<td>Pastes an image from the clipboard to the database image field.</td>
</tr>
<tr>
<td>F8</td>
<td>Freeze</td>
<td>Freezes an image.</td>
</tr>
</tbody>
</table>

General

<table>
<thead>
<tr>
<th>Key Combination</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+F4</td>
<td>Close</td>
<td>Closes the active Card/Batch Print Window.</td>
</tr>
<tr>
<td>Ctrl+F6</td>
<td>Next</td>
<td>Moves to the next Card/Batch Print Window.</td>
</tr>
<tr>
<td>Del</td>
<td>Delete</td>
<td>Deletes the selected object without copying it to the Clipboard.</td>
</tr>
</tbody>
</table>
Appendix C

Conditional Printing

C.1 Introduction

This appendix how to print different layouts based on one database field condition.
C.2 Procedure

1. Connect to a database; e.g., Card.mdb, available with CardStudio.
2. Create Layout 1.

3. Click on New (circled above), select the *Duplicate Layout* radio button, and click on the OK button.
4. Create Layout 2; e.g., change the background.
5. Select Settings (circled below) in order to configure the conditional layouts.

a. From the DB Field dropdown menu, choose the database field that will be the layout controller; in this case, choose Gender (F = female and M = male).

b. Enter conditional setting F for Layout 1, and enter conditional setting M for Layout 2.

c. Set the appropriate Auto Select option:

   • If Auto Select on Design View is checked, you can see the layouts changing on Design View according to the conditional settings and database field.

   • If Auto Select on Database View is checked, you can see the layouts changing on Database View according to the conditional settings and database field.
6. As you move between database records, you will see the layouts change according to the conditions you defined in Step 5.

Female records (Gender F) will display Layout 1.

Male records (Gender M) will display Layout 2.

7. When printing, the cards will be printed according to the conditions you defined in Step 5.
D.1 Introduction

The FaceSnap automates the pre-processing and production of portrait photos for passports, identification cards, etc.

An input image can be acquired (e.g., from a standard TWAIN device or from a file) and then be checked for an available face with the FaceSnap. If a face has been detected successfully, the module generates an output image that is standardized in size and luminance.
D.2 FaceSnap Setup

**Note** • The following points or quality characteristics for the acquisition of images should be taken into consideration in order to succeed in the face detection and to achieve a high quality output image:

- There is sufficient margin to crop the face from the input image.
- The image is focused and not blurred.
- The frontal face is 15% turned (maximum) or both eyes are visible.
- The face is not rotated.

1. Click on the *Options* icon on the toolbar, then select *Imager Settings*.

2. View the *Imager settings* window.

3. Select the *Auto Face Recognition and Crop* checkbox. *FaceSnap* will always be called for Image Acquisition.

4. Click on the *Properties* button.
5. View the Properties window.

6. Make desired brightness, contrast, and color adjustments (circled above):

   - **Brightness and Contrast** sliders changes the luminance of the output image.

   - **Automatic Pre-Normalization** checkbox:
     
     If not checked, the brightness and contrast of the image can be increased or decreased by the slider controls. If brightness and contrast are both set to zero, the output image has the same illumination as the input image.

     If checked, the output image will be normalized to a standard illumination (pre-normalized). By changing the values for brightness and contrast the standard values, the pre-normalization will be increased or decreased.

     Furthermore, it is possible to change contrast and brightness for a single image without saving the values as permanent settings.

   - **Auto Correction of Face Color** checkbox:
     
     If not checked, the color of the output image (the color of the face) will not be corrected automatically.

     If checked, the color of the output image (the color of the face) will be corrected automatically. Thus, a slightly color-distorted face can be restored to the original color. If the color of the face is natural, the color will not be adjusted.
7. Make desired image margins and positioning adjustments (circled below):

- **Zoom** determines the size of the region that is cropped from the source image relative to the size of the found face (face box). Thus, faces with different sizes or resolutions have a constant size and margin in the resulting image.

  The slider provides a range of values for the actual image. If the face is situated near the border of the input image and the scaled and cropped image region exceeds the border of the input image, the result image will be padded (filled with white) automatically.

  - A value of 0 provides the face region that includes eyes, nose, and mouth.
  - A value of 200 means that the left and right margins in the result image have the same dimensions as the face region.

- **Vertical Offset** moves the image in the window up or down. Moving the slider to the right (positive offset) moves the image up. Moving the slider to the left (negative offset) moves the image down.

- **Horizontal Offset** moves the image in the window left or right. Moving the slider to the right (positive offset) moves the image to the right. Moving the slider to the left (negative offset) moves the image to the left.

- **Auto Offset** checkbox: If checked and the crop region exceeds the border of the input image, so that the image has to be padded, the cropped face image will be moved automatically by the amount of the inserted space.

  Additionally, the Auto Offset function slightly corrects the horizontal offset of the face within the output image. A slightly rotated face is better centered in the output image.
8. Make desired face detection adjustment (circled below):

- Camera Rotation normally finds faces only if they appear in an approximately upright position in an image. In some applications it may be useful to rotate the camera so that the original camera image is always in portrait format.

With the icon buttons under “Camera Rotations” the standard rotational orientation of a face in the image can be set other than upright.

**Note** • By pressing the *Properties OK* button, the settings will only be accepted for the actual loaded image. The properties will not be saved permanently for further image acquisition sessions. By pressing the *Properties Cancel* button, the window will be closed without accepting changed values.

9. Click on the Properties *OK* button. The *Properties* window will close.

**Note** • By pressing the *Imager settings OK* button, the changed settings take effect permanently. The result image will be updated if settings for cropping the face or normalizing the image are edited. If the parameters for face detection are changed, it is required to repeat the face detection to see the effects.

10. Click on the *OK* icon. The *Imager settings* window will close.
D.3 Using FaceSnap

1. Click on the **Live Image** button.

2. Move the pointer to the location on the card where you want to place the upper left-hand corner of the image.

3. Press and hold the left mouse button, and drag from left to right. As you drag, an image frame forms. Continue dragging until the frame is the desired size, then release the mouse button.

4. Preview the image in the Imager.

5. Click on the **Take Picture** button.

6. Activate FaceSnap by clicking on the **FaceSnap** button.

7. Preview the FaceSnap image.
   a. If the image in the preview window is OK, go to Step 8.
   b. If the image needs adjusting, click in the **Imager settings** button, make the necessary adjustments (see Section D.2), exit the **Imager settings** window, click on the **Live Image** button, and go to Step 4.
   c. Otherwise, click on the **Live Image** button, and go to Step 4.

8. Click on the **OK** button.
E.1 Introduction

This section details the barcodes, both 1-dimensional and 2-dimensional) that are supported by CardStudio.
### E.2 1-Dimensional Bar Codes

The following 1-dimensional barcodes are supported:

<table>
<thead>
<tr>
<th>Code Number</th>
<th>Barcode Type</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>E.2.1</td>
<td>Codabar</td>
<td>171</td>
</tr>
<tr>
<td>E.2.2</td>
<td>Code 128</td>
<td>171</td>
</tr>
<tr>
<td>E.2.3</td>
<td>Code 39</td>
<td>171</td>
</tr>
<tr>
<td>E.2.4</td>
<td>Code 93</td>
<td>171</td>
</tr>
<tr>
<td>E.2.5</td>
<td>EAN/JAN-13</td>
<td>172</td>
</tr>
<tr>
<td>E.2.6</td>
<td>EAN/JAN-8</td>
<td>172</td>
</tr>
<tr>
<td>E.2.7</td>
<td>Extended Code 39</td>
<td>172</td>
</tr>
<tr>
<td>E.2.8</td>
<td>Extended Code 93</td>
<td>172</td>
</tr>
<tr>
<td>E.2.9</td>
<td>Interleaved 2 of 5</td>
<td>172</td>
</tr>
<tr>
<td>E.2.10</td>
<td>MSI Plessey</td>
<td>173</td>
</tr>
<tr>
<td>E.2.11</td>
<td>RM4SCC</td>
<td>173</td>
</tr>
<tr>
<td>E.2.12</td>
<td>Telepen</td>
<td>173</td>
</tr>
<tr>
<td>E.2.13</td>
<td>UCC/EAN-128</td>
<td>174</td>
</tr>
<tr>
<td>E.2.14</td>
<td>UPC-A</td>
<td>174</td>
</tr>
<tr>
<td>E.2.15</td>
<td>UPC-E</td>
<td>174</td>
</tr>
<tr>
<td>E.2.16</td>
<td>Zip+4 Postnet</td>
<td>174</td>
</tr>
</tbody>
</table>
E.2.1 Codabar

Codabar is a numeric, variable length, discrete, self-checking, two-element width symbology used mostly by libraries, package tracking systems, and blood banks. Developed in 1972, it was one of the original bar code symbologies. The numbers 0 through 9 and the following six characters comprise its character set: $ : / . + -

E.2.2 Code 128

Code 128 is a variable length, alphanumeric, continuous, multiple-element width, high-density symbology used in the shipping industry and on labels.

The Code 128 character set comprises the full 128 ASCII character set, and will use the least amount of space for data of six characters or more of any one-dimensional symbology. Each printed character can have one of three different meanings, depending on which of three different character sets (A, B or C) is employed.

Three different start characters tell the scanner which of the character sets is initially being used, and three shift codes permit changing character sets inside a symbol. Note that every Code 128 symbol ends with a check character.

♦ Code Subset A: includes all of the standard uppercase alphanumeric keyboard characters plus the control and special characters.
♦ Code Subset B: includes all of the standard uppercase alphanumeric keyboard characters plus lowercase alphabetic and the special characters.
♦ Code Subset C: includes the set of 100 digits pairs from 00 to 99 inclusive, as well as special characters. This enables double-density numeric digits (two digits per bar-coded character) to be encoded.

E.2.3 Code 39

Code 39 (also called 3 of 9) is a variable length, discrete, self-checking, two-element width symbology that was the first alphanumeric symbology to be developed. Code 39 is the most widely used bar code for industrial and commercial (non-retail) purposes in the world.

Every Code 39 character has five bars and four spaces, making a total of nine elements. Three of the elements are wide, hence the name 3 of 9. While being very accurate, Code 39 is not a very dense bar code symbology, taking many bars and spaces to represent a single character.

The Code 39 character set consists of the numbers 0 through 9, the upper-case alphabet, and the following characters: - . $ / + % and Space. Asterisks are reserved as the start and stop characters.
E.2.4  **Code 93**

Code 93 is a variable length, alphanumeric, continuous, four-element width symbology specifically designed to complement Code 39. The two symbologies can be freely mixed in an environment with no software change required. Because of its small size, it is used on electronic components, but it is a not very popular bar code symbology.

Code 93 encodes 43 data characters consisting of: 0-9, A-Z, six symbols and space, four control characters and a unique start/stop character. The entire ASCII character set can be encoded using the expanded version similar to Code 39. Code 93 can encode the same characters as Code 39, but has the advantage of being smaller.

E.2.5  **EAN/JAN-13**

EAN-13 is one of two versions of the European Article Numbering system (EAN) and is a superset of UPC. EAN-13 has the same number of bars as UPC version A, but encodes the 13th digit. The 12th and 13th digits define the country code. The codes 00-04 and 06-09 are assigned to the United States. The EAN-13 code numbers are assigned by numerous international agencies.

EAN-13 code supports the numeric characters: 0123456789

EAN-13 bar code height, by specification, is six individual EAN-13 bar code characters high.

E.2.6  **EAN/JAN-8**

European Article Numbering, now also called IAN (International Article Numbering), is the international standard bar code for retail food packages corresponding to the Universal Product Code (UPC) in the United States. The symbology is used to encode a seven-digit EAN-8 number. The eighth digit is a check digit that is automatically generated by the printer. The EAN code number and check digit are assigned by numerous international agencies.

EAN-8 code supports the numeric characters: 0123456789

EAN-8 bar code height, by specification, is six (6) individual EAN-8 bar code characters high.

E.2.7  **Extended Code 39**

The Extended Code 39 bar code supports every character in the ASCII set, except for ASCII 0 and those above ASCII 127. This enables full support of upper case and lower case letters, as well as control codes.

E.2.8  **Extended Code 93**

The Extended Code 93 bar code uses Code 93 to encode the entire 128 ASCII characters.
E.2.9 **Interleaved 2 of 5**

The name Interleaved 2 of 5 is derived from the method used to encode two characters. In the symbol, two characters are paired, using bars to represent the first and the interleaved spaces to represent the second character. Each character has two sets, one bars and one spaces. Each consisting of two wide elements and three narrow elements. Bars and spaces are wide or narrow and the wide bars are set by the ratio. It will be automatically added a leading zero (0) to the odd number of bar code data characters.

Interleaved 2 of 5 supports the numeric characters: 0123456789

The supported ratio of narrow bar to wide bar widths are: 2:1, 2:5 (2.5:1), and 3:1.

The minimum recommended height of the Interleaved 2 of 5 bar code is 0.25 inches (6.35 mm) or 75 dots.

E.2.10 **MSI Plessey**

MSI is a numeric, variable-length (up to 15 digits), continuous, low-density, symbology developed in the early 1970s for (mainly) retail shelf marking and inventory control.

Each four-bit character is 12 units wide, with each zero bit being a one-unit bar followed by a two-unit space, and each one bit being a two-unit bar followed by a one-unit space.

The complete symbol includes a start pattern, data characters, one or two check digits, and a stop pattern. Though MSI is a variable-length symbology, it is usually used in a fixed-length format since it is not self-checking.

The character set comprises the ten digits (0 through 9) and plus six additional characters.

E.2.11 **RM4SCC**

RM4SCC (Royal Mail 4-State Customer Code) is used for directing mail. The codes contain a start and stop bit, while the 4 State code does not. While both codes offer the option of a check digit, it should be noted that the Royal Mail code must include the check digit (which should be calculated automatically). These codes are based on the UK Post Code system, but may also contain an International Prefix and a Delivery Point Suffix.

Note that in both RM4SCC and 4 State, all characters are converted to upper case prior to encoding and any illegal characters with ASCII codes >32 are converted to X.

Illegal characters with ASCII codes <= 32 are ignored -- so spaces and carriage returns are ignored.
**E.2.12 Telepen**

Telepen is a continuous barcode, which encodes the full ASCII character set, it provides three coding schemes, each having its own pair of start and stop characters:

**Full ASCII** – encodes the lower 128 ASCII characters

**Compressed Numeric** – where the encoding starts in compressed numeric mode (encoding two digits per group of bars) and may be followed by ASCII encoding. This scheme is for encoding an even number of digits. If an odd number of digits is to be encoded then either a switch from Compressed numeric to ASCII is required before the final digit or the string of digits must be prefixed with a 0.

**ASCII** – where the encoding starts in full ASCII mode and is followed by digits in compressed numeric encoding.

The switch from ASCII to Compressed numeric (or vice versa) is accomplished by the insertion of an ASCII DLE character, but this is permitted only once in any symbol.

The barcode library provides standard Telepen (in which the above are followed), Telepen N (which uses the above scheme but forces the full ASCII start and stop bars), and Telepen A (which encodes all data as ASCII without compressed numeric). The Telepen ASCII mode provides the full ASCII character set. Codes below 32 (space) may be entered as <ALT>0XYZ, where XYZ is the 3 digits ASCII code +128.

**E.2.13 UCC/EAN-128**

UCC-128 is the name given by the Uniform Code Council to a specially defined subset of Code 128 used most often for shipping containers.

**E.2.14 UPC-A**

UPC-A (Universal Product Code) is a numeric, fixed-length (12 digits), continuous, four-element width symbology and encoding system, used since 1973 almost exclusively by the retail industry. This makes UPC the most widely used bar code in North America.

This barcode was designed to uniquely identify a product and its manufacturer. In the U.S., the Uniform Code Council in Dayton, Ohio assigns manufacturers numbers.

It is important to differentiate between the UPC coding scheme and the UPC symbology. The actual UPC code is a 10-digit code: the first five digits represent the manufacturer, and the next five digits contain a unique product number. This 10-digit code is preceded by a “number system” digit and followed by a check digit, based on the preceding 11 digits and used for error detection.
E.2.15  UPC-E

UPC-E is also a numeric, fixed-length symbology, but is limited to six digits versus the 10 digits of UPC-A. It is used where space is at a premium, such as a small product label.

The application supports three forms of UPC-E. You can select UPC-E System 0 to enter six numbers and let the application give you a bar code with those same digits for system number 0. Choosing UPC-E System 1 gives you the same six numbers for system number 1. If you choose UPC-E11, you are required to perform a zero-suppression check.

E.2.16  Zip+4 Postnet

The Zip+4 Postal Code (POSTNET Bar Code) is a bar code that is placed on envelopes or postcards to be mailed. The United States Postal Service (USPS) uses it.

The POSTNET bar code is made up of evenly-spaced tall and short bars. There 5, 9, or 11 digits plus a correction digit encoded into every POSTNET.
## E.3 2-Dimensional Bar Codes

The following 2-dimensional barcodes are supported:

<table>
<thead>
<tr>
<th>Barcode</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>E.3.1 Aztec</td>
<td>176</td>
</tr>
<tr>
<td>E.3.2 Codablock F</td>
<td>176</td>
</tr>
<tr>
<td>E.3.3 Code 16K</td>
<td>177</td>
</tr>
<tr>
<td>E.3.4 Code 49</td>
<td>177</td>
</tr>
<tr>
<td>E.3.5 Datamatrix</td>
<td>178</td>
</tr>
<tr>
<td>E.3.6 Maxicode</td>
<td>178</td>
</tr>
<tr>
<td>E.3.7 MicroPDF417</td>
<td>180</td>
</tr>
<tr>
<td>E.3.8 PDF417</td>
<td>181</td>
</tr>
<tr>
<td>E.3.9 QR Code</td>
<td>184</td>
</tr>
<tr>
<td>E.3.10 RSS</td>
<td>185</td>
</tr>
</tbody>
</table>
E.3.1 Aztec

Aztec is a matrix symbology which supports the entire ASCII character set and offers several error checking modes. Aztec symbols are square and may be read at any orientation.

The symbol is made up of squares which "grow" from the centre around a centre mark. The size of the symbol is characterized by the number of "layers" outside the centre mark, and this can range from 1 – 32.

For Aztec symbols in Normal mode, the user may select any percentage of the symbol to contain error checking data within the range 1 – 99%. This is the Security Level in Barcode 2D. If a value of 0% is used then the symbol will actually be produced with the default amount of error correction (which is 23% + 3 code words). The higher the security level the greater will be the number of layers required to contain the symbol – and hence its overall size.

In Compact mode the user specifies the number of layers used to contain the symbols information – and this is restricted to the range 1 – 4. Library will insert error correction data in the space available.

In Full range mode again the user specifies the number of layers allowed for the symbol, but this time the range is 1 – 32. Again error correction data is used to fill otherwise unused space in the specified number of layers.

In Full range mode, maximum capacity of Aztec Code symbols is approximately as follows:

♦ Digits only – maximum capacity 3800 digits
♦ Alphanumeric text – maximum capacity 3000 characters. Note that capital letters, punctuation and new lines/paragraphs reduce this value.
♦ Byte values – maximum capacity 1900 bytes
♦ Runes are special symbols consisting of a single layer and have no security options.
♦ Appended symbols are not supported at this time.

E.3.2 Codablock F

Codablock F is a stacked barcode symbology based on Code 128. It can encode the full ASCII character set in a symbol which consists of multiple rows of Code 128 type symbols, using a common “Start A” start character and a common “Stop” stop character. Apart from the start and stop character the other characters in adjacent rows have a horizontal line between them.

Each row in a Codablock symbol contains (in addition to the common start and stop characters) a subset selector, a row indicator and a check digit, along with a number of data characters. This enables each row to be read by Code 128 scanners.

Codablock symbols can hold a maximum of 2725 characters, although this value is significantly reduced by the presence of subset change characters. Codablock symbols can have between 2 and 44 rows, and each row can hold between 4 and 62 characters plus the subset selector, row indicator and check digit.

Codablock symbols are character self-checking and may be scanned in any direction. The subtypes used in the symbol are essential identical with those use in Code 128 symbology.
Barcode Details

E.3.3 Code 16K

Code 16k is a stacked barcode of the type illustrated below.

Code 16k encodes characters using a reverse video version of Code 128. Each row starts and ends with a UPC digit, which indicates the row number and the direction of scan. Each row encodes 5 data characters and the Code 128 type C mode is used for numeric-only strings. A maximum of 16 rows are permitted.

Code 16k has three coding schemes and permit the inclusion of special characters not present on the keyboard. If no coding scheme is specified scheme B is used by default. Scheme C is used for any code, which has numbers in the first four digits. An alternative scheme may be selected within Barcode 2D from the allowed modes:

<table>
<thead>
<tr>
<th>Start mode</th>
<th>Code set</th>
<th>Leading char</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>A</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>B</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>B</td>
<td>Fncl</td>
</tr>
<tr>
<td>4</td>
<td>C</td>
<td>Fncl</td>
</tr>
<tr>
<td>5</td>
<td>C</td>
<td>Shift B</td>
</tr>
<tr>
<td>6</td>
<td>C</td>
<td>Double Shift B</td>
</tr>
</tbody>
</table>

Other function and shift characters are as specified below (typed as <ALT>0XYZ).

<table>
<thead>
<tr>
<th>XYZ</th>
<th>Character</th>
<th>Code A</th>
<th>Code B</th>
<th>Code C</th>
</tr>
</thead>
<tbody>
<tr>
<td>197</td>
<td>Å</td>
<td>DEL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>198</td>
<td>Æ</td>
<td>func. 3</td>
<td>func. 3</td>
<td></td>
</tr>
<tr>
<td>199</td>
<td>Ç</td>
<td>func. 2</td>
<td>func. 2</td>
<td></td>
</tr>
<tr>
<td>200</td>
<td>È</td>
<td>shift</td>
<td>shift</td>
<td></td>
</tr>
<tr>
<td>201</td>
<td>Ê</td>
<td>code C</td>
<td>code C</td>
<td></td>
</tr>
<tr>
<td>202</td>
<td>Ë</td>
<td>code B</td>
<td>func. 4</td>
<td>code B</td>
</tr>
<tr>
<td>203</td>
<td>É</td>
<td>func. 4</td>
<td>code A</td>
<td>code A</td>
</tr>
<tr>
<td>204</td>
<td>Í</td>
<td>func. 1</td>
<td>func. 1</td>
<td>func. 1</td>
</tr>
<tr>
<td>205</td>
<td>Ì</td>
<td>Start A</td>
<td>Start A</td>
<td>Start A</td>
</tr>
<tr>
<td>206</td>
<td>Í</td>
<td>Start B</td>
<td>Start B</td>
<td>Start B</td>
</tr>
<tr>
<td>207</td>
<td>Ì</td>
<td>Start C</td>
<td>Start C</td>
<td>Start C</td>
</tr>
<tr>
<td>208</td>
<td>D</td>
<td>NUL</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
E.3.4 Code 49

A code 49 symbol is a stacked symbol containing between 2 and 8 rows, each separated by a separator bar.

Each row contains 16 “words” (generated from character pairs) and a start and stop character. The last row also contains the number of rows in the symbol and the check digit characters.

There are 2400 possible words which can be generated from each pair of characters (by taking the value of the right hand character plus 49 times the value of the left hand character). Symbols with less than 7 rows contain 2 check digits in the final row. Symbols with 7 or 8 rows contain 3 check digits in the final row.

A numeric mode allows 5 digits to be encoded in the same space as three alphanumeric characters, so offering a higher density.

Encoding Code 49 symbols may be accomplished in Auto mode.

E.3.5 Datamatrix

Datamatrix is a two dimensional matrix symbology which is made up of square modules arranged within a finder pattern. DataMatrix symbols may be square or rectangular.

DataMatrix symbols can include a user-selected amount of error-correction data.

For Square symbols the Security Level setting may be in the range 0 – 24, while for Rectangular symbols the allowed range is 0 – 6.

DataMatrix symbols can encode the entire ASCII character set and uses multiple encoding modes which are, in order of efficiency:

♦ Double digits – maximum capacity 3100 digits
♦ Alphanumeric text – maximum capacity 2300 characters. Note that capital letters, punctuation and new lines/paragraphs reduce this value.
♦ Byte values – maximum capacity 1550 bytes

2D barcode products support only ECC200 symbols – the older ECC140 and below are not supported. Also at this time ECI and Appended symbols are not supported.
MaxiCode is characterized by the two messages, which make up its data content – the Primary message and Secondary message. The symbology may be used in 5 modes which utilize the two messages in different ways and with different levels of error correction, as shown in the table below:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Obsolete (not supported)</td>
</tr>
<tr>
<td>1</td>
<td>Obsolete (not supported)</td>
</tr>
<tr>
<td>2</td>
<td>Primary message encodes: numeric postal code, country code, and service code; secondary message encodes: additional data.</td>
</tr>
<tr>
<td>3</td>
<td>Primary message encodes: alphanumeric postal code, country code, and service code; secondary message encodes: additional data.</td>
</tr>
<tr>
<td>4</td>
<td>Any data up to 84 data characters automatically split between primary and secondary messages.</td>
</tr>
<tr>
<td>5</td>
<td>Any data up to 68 data characters automatically split between primary and secondary messages. Enhanced error correction used.</td>
</tr>
<tr>
<td>6</td>
<td>Similar to 4, but used for reader control.</td>
</tr>
</tbody>
</table>

In modes 4, 5, and 6, virtually any ASCII data may be encoded up to the maximum number of data characters allowed. However, encoding introduces additional shift and latch characters whenever characters other than uppercase letters and numbers are used and the maximum length of text becomes correspondingly smaller.

Modes 2 and 3 are for Structured Carrier Messages and require specific data in the correct order to produce a scan able symbol. Basically, the data consists of the sequence:

```
postal code G country code G service class G secondary message
```

where the four components are separated by ASCII 29 characters, shown as G.

In Mode 2, the postal code must be numeric only and up to 9 digits. In Mode 3, the postal code may be up to 6 alphanumeric characters. The country code and service class elements must be three digits each.

Mode 2 or 3 message which begin with the sever character sequence [)>R01G (where G is ASCII 29 and R is ASCII 30) are treated in the special way described in the MaxiCode specification.

Any secondary message can terminated with an End of Transmission character (ASCII 4).
Because the non-printable ASCII characters are a required part of MaxiCode messages in Modes 2 and 3, software recognizes the following keyboard sequences for the entry of such characters:

<table>
<thead>
<tr>
<th>Sequence</th>
<th>Alternative</th>
<th>ASCII value</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;FS&gt;</td>
<td>{FS}</td>
<td>28</td>
</tr>
<tr>
<td>&lt;GS&gt;</td>
<td>{GS}</td>
<td>29</td>
</tr>
<tr>
<td>&lt;RS&gt;</td>
<td>{RS}</td>
<td>30</td>
</tr>
<tr>
<td>&lt;ET&gt;</td>
<td>{ET}</td>
<td>4</td>
</tr>
</tbody>
</table>

A typical string for a Mode 2 Maxicode is:

```
[]><RS>01<GS>96152382802<GS>840<GS>001<GS>1Z00004951<GS>UPSN<GS>06X10<GS>159<GS>1234567<GS>1/1<GS><GS>Y<GS>634 ALPHA DR<GS>PITTSBURGH<GS>PA<RS><ET>
```

Appended symbols are not supported by software at this time.

MaxiCode symbols are sensitive to the gap between hexagons. For printing on a 300 dpi laser, we recommend the line width reduction parameter be set to 12.
E.3.7 MicroPDF417

MicroPDF417 is a multi-row symbology based on PDF417 designed for applications requiring a greater area efficiency but lower data capacity than PDF417. A specific and limited set of symbol sizes is available, each size including a fixed level of error correction.

MicroPDF417 provides for three encoding modes: Text, Byte and Numeric compaction. Text is for general text, Numeric for encoding data consisting only of digits, and Byte to allow for the first 127 ASCII characters but with a reduced level of efficiency. Four symbol widths are permitted, each specifying the number of data columns (1 – 4).

Within each symbol width, a variable number of rows provides for a maximum data capacity of:

- ♦ Text compaction mode 0: 250 characters (2 data characters per code word)
- ♦ Byte compaction mode 1: 150 characters (1.2 data characters per code word)
- ♦ Numeric compaction mode 2: 366 characters (2.93 data characters per code word)

The following additional parameters are allowed for each symbol:

- ♦ Level/Columns: Number of data columns in the symbol. (1 – 4)
- ♦ X-unit: Thickness of thinnest bar in mils (4 – 200)
- ♦ Y-multiplier: Height of each bar in X-units (2 – 5)

The industry standard Macro sequences [)>\{RS\}05\{GS\} and [)>\{RS\}06\{GS\} are supported (where {RS} represents ASCII 30 and {GS} is ASCII 29).

The following character translations are made if the Flag is set (the flag checkbox in applications or the AztecFlag property in components)

<table>
<thead>
<tr>
<th>String</th>
<th>Converted to</th>
</tr>
</thead>
<tbody>
<tr>
<td>{ET}</td>
<td>ASCII 4</td>
</tr>
<tr>
<td>{FS}</td>
<td>ASCII 28</td>
</tr>
<tr>
<td>{GS}</td>
<td>ASCII 29</td>
</tr>
<tr>
<td>{RS}</td>
<td>ASCII 30</td>
</tr>
</tbody>
</table>

Appended symbols are not supported at this time.
E.3.8 PDF417

PDF417 is a multi-row, two-dimensional, high-capacity, high-density bar code developed by Symbol Technologies, Inc. and announced in 1990. It essentially consists of a stacked set of smaller bar codes. The symbology is capable of encoding the entire (255 character) ASCII set. PDF stands for “Portable Data File” because it can encode as many as 2725 data characters in a single bar code comprising 17 modules, each containing 4 bars and spaces (thus the number 417). Each symbol has a start and stop bar group that extends the height of the symbol.

The complete specification for PDF417 provides many encoding options including data compression options, error detection and correction options, and variable size and aspect ratio symbols. The low level structure of a PDF417 symbol consists of an array of code words (small bar and space patterns) that are grouped together and stacked on top of each other to produce the complete printed symbol. An individual code word consists of a bar and space pattern, 17 modules wide. The user may specify the module width, the module height, and the overall aspect ratio (overall height to width ratio) for the complete symbol. A complete PDF417 symbol consists of at least 3 rows of up to 30 code words and may contain up to 90 code word rows per symbol with a maximum of 928 code words per symbol.

The code words in a PDF417 symbol are generated using one of three data compression modes currently defined in the symbology specifications. This allows more than one character to be encoded into a single data code word. Because different data compression algorithms may be used, it is possible for different printed symbols to be created from the same input data.

The symbology also allows for varying degrees of data security or error correction and detection. Nine different security levels are available with each higher level adding additional overhead to the printed symbol.

Using a higher level of security will give you a better chance to decode information in a damaged bar code.

The error-correction capability uses built-in error detection code words, to reconstruct partially destroyed bar codes. It works by checking the value of columns and rows, and then calculating and rebuilding the data missing from any damaged cells.

PDF417 symbols may include extensive error-correction enabling data to be recovered from a symbol which has been damaged or corrupted.

There are 900 different patterns (code words) which may be incorporated into a PDF417 symbol, and several modes available for encoding.
Barcode Details

Encoding Modes

EXC (Extended Alphanumeric Compaction mode) - allows encoding of all printable ASCII characters into about 2 characters per code word. Within the EXC mode there are several submodes:

EXC Alpha - starts in upper case.
EXC Lower - starts in lower case.
EXC Mixed - numeric and other punctuation.
EXC Punctuation - punctuation & bracket characters.

Binary/ASCII Plus mode - allows encoding of 256 international characters including the full ASCII set plus any 8-bit value in the range 0 - 255. This mode allows encoding approximately 1.2 bytes per code word and is considerably less efficient than EXC mode.

Numeric mode - allows encoding of a string of digits with a density of approximately 2.95 digits per code word. Recommended where more than 13 digits are to be encoded. Numeric mode symbols may not contain nonnumeric characters.

The maximum capacity of PDF417 symbols is approximately as follows:

- Numeric mode – maximum capacity 2700 digits. Note that capital letters, punctuation, mode shifts and new lines/paragraphs reduce these value.
- Alphanumeric text – maximum capacity 1800 characters. Note that capital letters, punctuation, mode shifts and new lines/paragraphs reduce these value.
- Byte values – maximum capacity 1100 bytes

Security level

One of PDF417’s most valuable features is its ability to allow correction of errors. This ability is provided by the inclusion of additional code words within the symbol, so that the data code words may be reconstructed even if some are defaced or misread.

The number of damaged code words (Nmax) which may be recovered depends on the security level (which in turn determines the number of additional characters included in the symbol).

<table>
<thead>
<tr>
<th>Security Level</th>
<th>Nmax</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>2</td>
<td>6</td>
</tr>
<tr>
<td>3</td>
<td>14</td>
</tr>
<tr>
<td>4</td>
<td>30</td>
</tr>
<tr>
<td>5</td>
<td>62</td>
</tr>
<tr>
<td>6</td>
<td>126</td>
</tr>
<tr>
<td>7</td>
<td>154</td>
</tr>
<tr>
<td>8</td>
<td>510</td>
</tr>
</tbody>
</table>
Aspect ratio

PDF417 symbols may be reproduced with different number of code words per row, and therefore in several different height to width ratios.

The user may select the target ratio (as either the height to width ratio or the number of rows/number of code words per row). In general tall, thin barcodes read more reliable than short, wide symbols, although there may be restrictions applied by the type of barcode scanner employed.

The library will attempt to form a symbol which meets a target height to width ratio, but users should note that some things are just not possible!

The following character translations are made if the Flag is set (the flag checkbox in applications or the AztecFlag property in components)

<table>
<thead>
<tr>
<th>String</th>
<th>converted to</th>
</tr>
</thead>
<tbody>
<tr>
<td>{ET}</td>
<td>ASCII 4</td>
</tr>
<tr>
<td>{FS}</td>
<td>ASCII 28</td>
</tr>
<tr>
<td>{GS}</td>
<td>ASCII 29</td>
</tr>
<tr>
<td>{RS}</td>
<td>ASCII 30</td>
</tr>
</tbody>
</table>

Appended symbols are not supported at this time.
E.3.9 QR Code

QR Code is a matrix symbology consisting of a square array of modules with a finder pattern located at three corners. A wide range of symbol sizes is supported along with four levels of error correction, and the symbology is noted for its high data density.

The libraries support QR Code Version 2 in Numeric, Alphanumeric and Byte modes. (Kanji mode is not supported at this time).

The maximum data capacity of the symbols (at Level 0 error correction) are:

- Numeric data 7089 digits
- Alphanumeric data 4296 characters
- Byte data 2953 bytes

Note that Alphanumeric includes digits and uppercase letters, the space and the $ % * + - . / : characters only.

The Reed-Solomon error correction allows the following recovery of damaged code words:

- Level 0: 7%
- Level 1: 15%
- Level 2: 25%
- Level 3: 30%
E.3.10 RSS

The EAN.UCC Reduced Space Symbology (RSS) is a family containing three linear symbologies and three stacked variants.

RSS-14 encodes the full 14-digit EAN.UCC item identification in a linear symbol that can be scanned in any direction. RSS Limited encodes item identification suitable for use on small items, but not for use at point-of-sale.

RSS-Expanded encodes the 14-digit EAN.UCC item identification plus supplementary AI elements.

RSS-14 Stacked is a variant which is stacked in two rows, either as a truncated version (above) used for small item marking, or as an omni-directional version (below) designed to be read by omni-directional scanners.

The RSS-14 based versions encode the full 14 digit EAN.UCC item identification number and this may be prefixed with the (01) AI – although this is NOT encoded.

The RSS implementation uses the following Start Mode property values to specify the symbol:

<table>
<thead>
<tr>
<th>Start Mode</th>
<th>RSS version</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>RSS-14</td>
</tr>
<tr>
<td>1</td>
<td>RSS-14 Truncated</td>
</tr>
<tr>
<td>2</td>
<td>RSS Limited</td>
</tr>
<tr>
<td>3</td>
<td>RSS-14 Stacked</td>
</tr>
<tr>
<td>4</td>
<td>RSS-14 Stacked Omnidirectional</td>
</tr>
<tr>
<td>5</td>
<td>RSS Expanded</td>
</tr>
<tr>
<td>6</td>
<td>RSS Expanded Stacked</td>
</tr>
</tbody>
</table>

All RSS symbols are based on X-unit size, where the Y-unit (height) is treated as a multiplier of the X-unit value. The following height values should be used:

- RSS-14: a minimum height of 33 X
- RSS Truncated: a minimum height of 13 X
- RSS-14 Stacked: a fixed height (top row 5 X, bottom row 7 X, separator 1 X)
- RSS-14 Stacked Omnidirectional: minimum height 33 X (each row)
- RSS Limited: minimum height 10 X.
- RSS Expanded: minimum height 34 X
- RSS Expanded may also be used in a stacked version, and the extent of stacking may be specified using the Aspect Ratio property, which can range be set between 1 and 10, where the value represents the width of the symbol in segment pairs. Again each row shall have a minimum height of 34 X.
RSS Expanded may be used to encode AIs in addition to the item identification number as listed below:

(01).. (xx) ..........  
(01).. (3103) ...... - 6 digit metric weight  
(01).. (3202) ...... - 6 digit pound weight  
(01).. (392x1) ...... - 3 digit price  
(01).. (393x1) ...... - 3 digit ISO currency code followed by price  
(01).. (310x1) ...... (yy) .. - metric weight and six digit date  
(01).. (320x1) ...... (yy) .. - English weight and six digit date  

where yy may be 11 (production date), 13 (packaging date), 15 (best before date), or 17 (expiration date).

For Expanded types the Level setting value (default = 0) is used as the Linkage. (At the present time the library does not support linked barcode symbols, but the Linkage parameter may be used by developers wishing to support linked symbols.)
For Technical Support or Repair Services, contact the appropriate facility listed below.

**North America and Latin America - Technical Support**

- **T:** +1 877 ASK ZEBRA (877 275 9327)  
  +1 847 913 2259  
- **E:** ts1@zebra.com

**North America and Latin America - Repair Services**

Before returning any equipment to Zebra Technologies Corporation for in-warranty or out-of-warranty repair, contact Repair Services for a Repair Order (RO) number. Mark the RO number clearly on the outside of the box. Ship the equipment, freight prepaid, to the address listed below:

Zebra Technologies Repair Services  
333 Corporate Woods Parkway  
Vernon Hills, IL 60061

- **webform:** [www.zebra.com/repair](http://www.zebra.com/repair)  
- **T:** 1-877-275-9327  
- **E:** repair@zebra.com
Europe, Middle East, and Africa - Technical Support

<table>
<thead>
<tr>
<th>Language</th>
<th>Phone</th>
<th>Email</th>
</tr>
</thead>
<tbody>
<tr>
<td>German</td>
<td>+49 (0) 2159 676 870</td>
<td><a href="mailto:zebratechDE@zebra.com">zebratechDE@zebra.com</a></td>
</tr>
<tr>
<td>French</td>
<td>+33 (0) 1 53 48 12 74</td>
<td><a href="mailto:zebratechFR@zebra.com">zebratechFR@zebra.com</a></td>
</tr>
<tr>
<td>English</td>
<td>+44 (0) 1628 556 225</td>
<td><a href="mailto:zebratechUK@zebra.com">zebratechUK@zebra.com</a></td>
</tr>
</tbody>
</table>

For further assistance, contact:

Zebra Technologies Card Printer Solutions
Dukes Meadow
Millboard Road, Bourne End
Buckinghamshire SL8 5XF, UK

T: +44 (0) 1628 556 025
F: +44 (0) 1628 556 001
E: cardts@zebra.com

Europe, Middle East, and Africa - Repair Services

Before returning any equipment to Zebra Technologies Corporation for in-warranty or out-of-warranty repair, contact your supplier for a Return Materials Authorization (RMA) number, or contact one of the following repair centers for support and instructions:

<table>
<thead>
<tr>
<th>Type of repair and location</th>
<th>Phone</th>
<th>Email</th>
</tr>
</thead>
<tbody>
<tr>
<td>Depot Repair in Germany, Austria, Switzerland</td>
<td>+49 (0) 2159 676 870</td>
<td><a href="mailto:zebracareDE@zebra.com">zebracareDE@zebra.com</a></td>
</tr>
<tr>
<td>Depot Repair in France</td>
<td>+33 (0) 1 53 48 12 74</td>
<td><a href="mailto:zebracareFR@zebra.com">zebracareFR@zebra.com</a></td>
</tr>
<tr>
<td>Depot and On-Site Repair in UK and Ireland</td>
<td>+44 (0) 1628 556 225</td>
<td><a href="mailto:zebracareUK@zebra.com">zebracareUK@zebra.com</a></td>
</tr>
<tr>
<td>Depot Repair in South Africa</td>
<td>+27 (0) 11 201 7777</td>
<td>-</td>
</tr>
<tr>
<td>Depot Repair in the Middle East</td>
<td>+971 (0) 46058220</td>
<td><a href="mailto:support_dxb@emitac.ae">support_dxb@emitac.ae</a></td>
</tr>
</tbody>
</table>

For further assistance, contact:

For assistance anywhere in the EMEA, contact After Sales Customer Services at:

T: + 44 (0) 177 2 69 3069
E: ukrma@zebra.com
Asia Pacific - Technical Support

Zebra Technologies Asia Pacific Pte. Ltd.
120 Robinson Road
#06-01 Parakou Building
Singapore 068913

T: +65 6858 0722
F: +65 6885 0838
E: tsasiapacific@zebra.com

Asia Pacific - Repair Services

Before returning any equipment to Zebra Technologies Corporation for in-warranty or out-of-warranty repair, contact Repair Services for a Return Materials Authorization (RMA) number. Repack the equipment in the original packing material, and mark the RMA number clearly on the outside. Ship the equipment, freight prepaid, to either address listed below:

Zebra Technologies Asia Pacific Pte. Ltd.
No.5 Changi North Way Level 3
Singapore 498771
Agility Building

T: +65 6546 2670 ext 3203 and 3204
F: +65 6546 5328
E: APACRepair@zebra.com

Zebra Website

http://www.zebra.com